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Copyrights
The Motorola Solutions products described in this document may include copyrighted Motorola
Solutions computer programs. Laws in the United States and other countries preserve for Motorola
Solutions certain exclusive rights for copyrighted computer programs. Accordingly, any copyrighted
Motorola Solutions computer programs contained in the Motorola Solutions products described in this
document may not be copied or reproduced in any manner without the express written permission of
Motorola Solutions.
© 2018 Motorola Solutions, Inc. All Rights Reserved

No part of this document may be reproduced, transmitted, stored in a retrieval system, or translated
into any language or computer language, in any form or by any means, without the prior written
permission of Motorola Solutions, Inc.

Furthermore, the purchase of Motorola Solutions products shall not be deemed to grant either directly
or by implication, estoppel or otherwise, any license under the copyrights, patents or patent
applications of Motorola Solutions, except for the normal non-exclusive, royalty-free license to use that
arises by operation of law in the sale of a product.

Disclaimer
Please note that certain features, facilities, and capabilities described in this document may not be
applicable to or licensed for use on a specific system, or may be dependent upon the characteristics of
a specific mobile subscriber unit or configuration of certain parameters. Please refer to your Motorola
Solutions contact for further information.

Trademarks
MOTOROLA, MOTO, MOTOROLA SOLUTIONS, and the Stylized M Logo are trademarks or
registered trademarks of Motorola Trademark Holdings, LLC and are used under license. All other
trademarks are the property of their respective owners.

European Union (EU) Waste of Electrical and Electronic Equipment (WEEE)
directive

 The European Union's WEEE directive requires that products sold into EU countries must have
the crossed out trash bin label on the product (or the package in some cases).

As defined by the WEEE directive, this cross-out trash bin label means that customers and end-users
in EU countries should not dispose of electronic and electrical equipment or accessories in household
waste.

Customers or end-users in EU countries should contact their local equipment supplier representative or
service centre for information about the waste collection system in their country.
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Limited Hardware Warranty
This warranty for Motorola MCC 7100, MCC 7500 VPM, and MCC 7500E products is provided in lieu
of the Commercial Warranty (Standard) for certain Motorola Solutions manufactured products, as set
forth in General Information, Motorola Warranty of the Motorola Electronic Catalog (Domestic User
Price Book). This warranty is extended by Motorola Solutions, Inc., 1301 E. Algonquin Road,
Schaumburg, Illinois 60196, to the original end purchaser when purchasing for commercial, agricultural
or governmental use. This warranty is not assignable or transferable to any other party and applies
only within the 50 United States and Canada.

This plan extends the coverage of the Commercial Warranty (Standard) from one year parts and 120
days labor to one year parts and one year labor for Motorola MCC 7100, MCC 7500 VPM, and MCC
7500E products, with the first 120 days labor to be provided on-site, and labor for the remainder of the
year to be provided at the designated depot service center. ALL REFERENCES TO THE WARRANTY
PERIOD BEGIN AT TIME OF ORIGINAL SHIPMENT.

I. GENERAL PROVISIONS
This warranty sets forth the full extent of Motorola Solutions' responsibilities regarding the Product.
Motorola Solutions' total liability ad the purchaser's sole remedy for any breach of this warranty will be
limited to, at Motorola Solutions' option, repair, replacement or refund of the purchase price of the
product(s). MOTOROLA SOLUTIONS DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL
MOTOROLA SOLUTIONS BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES TO THE
FULL EXTEND SUCH MAY BE DISCLAIMED BY LAW.

II. WHAT THIS WARRANTY COVERS
Parts:
All Motorola MCC 7100, MCC 7500 VPM, and MCC 7500E product parts are warranted to be free from
defects in material and workmanship for a period of ONE (1) YEAR from the date of shipment.
Motorola Solutions will furnish free of charge parts that Motorola Solutions finds defective within the full
warranty period.

Labor:
Labor to repair to replace defective parts within the original shipped products will be provided for ONE
(1) YEAR from the date of purchase. Motorola Solutions will pay for on-site labor to repair or replace
any defective parts for one hundred twenty (120) days from the date of shipment. For the remainder of
the one (1) year period from the date of shipment, defective parts must be returned for depot repair.

THIS PLAN DOES NOT COVER defects, malfunctions, performance failures, or damages to the parts
resulting from:

Use in other than its normal and customary manner;

Misuse, vandalism, accident or neglect; or

Improper disassembly, testing, operation, maintenance, installation, modification, adjustment,
alteration, or repair.

III. HOW TO RECEIVE DEPOT WARRANTY SERVICE
All Motorola MCC 7100, MCC 7500 VPM, and MCC 7500E parts covered by the Warranty for Motorola
MCC 7100, MCC 7500 VPM, and MCC 7500E Products that require depot service must be sent or
taken to the Motorola Solutions Support Center. Please contact your Motorola Solutions representative
for detailed contact and shipping information. For more information, see Getting Help.
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Limited Software Warranty
For the first one hundred twenty (120) days following its initial shipment, Motorola Solutions warrants
that, when properly used, its software will be free from reproducible defects that cause a material
variance from its published specification. However, Motorola Solutions does not warrant that program
operation will be uninterrupted or error-free, that each defect will be corrected, or that any program will
meet Licensee's particular requirements.

Motorola Solutions' total liability and Licensee's sole remedy for any warranted software shall be limited
to, at Motorola Solutions' option, repair or replacement of Motorola Solutions software or the payment
of Licensee's actual damages, not to exceed the total licensed charge paid by Licensee to Motorola
Solutions for the item of software that caused the damage.

IN NO EVENT SHALL MOTOROLA SOLUTIONS BE LIABLE FOR SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES (INCLUDING WITHOUT LIMITATION LOSS OF USE, TIME OR
DATA, INCONVENIENCE, COMMERCIAL LOSS, LOST PROFITS OR SAVINGS) TO THE FULL
EXTENT SUCH MAY BE DISCLAIMED BY LAW EVEN IF MOTOROLA SOLUTIONS HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR FOR ANY CLAIM AGAINST LICENSEE
BY ANY OTHER PARTY.

MOTOROLA SOLUTIONS IS NOT RESPONSIBLE AND SPECIFICALLY DISCLAIMS ANY AND ALL
LIABILITY FOR (1) ANY HARDWARE, FIRMWARE OR SOFTWARE PROBLEMS CAUSED BY
CHANGES IN THE OPERATING CHARACTERISTICS OF COMPUTER HARDWARE OR
COMPUTER OPERATING SYSTEMS WHICH MAY BE MADE TO THE HOST COMPUTER, WHICH
CHANGES RE MADE AFTER THE RELEASE OF THE SOFTWARE PRODUCT AND ITS
INSTALLATION ON THE HOST COMPUTER; (2) ANY HARDWARE, FIRMWARE OR SOFTWARE
PROBLEMS WHICH ARE CAUSED, DIRECTLY OR INDIRECTLY, BY THE INTERACTION OF THE
SOFTWARE PRODUCT WITH NON-MOTOROLA MCC 7100, MCC 7500 VPM, AND MCC 7500E
SOFTWARE PRODUCTS; AND (3) ANY HARDWARE, FIRMWARE OR SOFTWARE
PERFORMANCE PROBLEMS WHICH ARE CAUSED, DIRECTLY OR INDIRECTLY, BY USING
NON-MOTOROLA MCC 7100, MCC 7500 VPM, AND MCC 7500E SOFTWARE ON THE SAME
HOST COMPUTER WITH THE SOFTWARE PRODUCT.

This warranty extends only to the first licensee; subsequent transferees accept these programs "as is"
and without warranties of any kind. THIS WARRANTY IS GIVEN IN LIEU OF ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THE WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
The classification of defects in Motorola Solutions supplied software shall be the responsibility of
Motorola Solutions. Remedy of defects is at the sole discretion of Motorola Solutions. If Motorola
Solutions agrees to remedy a software defect, the new software will be warranted until the end of the
original warranty period.

Replacement of any software defect shall constitute Motorola Solutions supplying the customer with
the appropriate software media and authorization key. Field installation and configuration are not
included.

All warranty service will be performed at service locations designated by Motorola Solutions. Travel
and associated expenses of the Licensee or such expenses incurred by Motorola Solutions for visits to
Licensee's location by Motorola Solutions personnel are not covered by this warranty. This warranty
does not cover an item of Software (i) used in other than its normal and customary manner; (ii) subject
to misuse; (iii) subjected to modifications by Licensee or by any party other than Motorola Solutions
without the prior written consent of Motorola Solutions.

For the first 120 days following its initial shipment, Motorola Solutions warrants that the media carrying
the software will be free from defects which damage the performance of the software. Motorola
Solutions will replace any damaged media free of charge during the warranty period. Warranted media
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is limited to that which is used to transport the software (e.g. disks and authorization key). PROMs
which may store the software in equipment are covered in the hardware warranty.

Field software updates/upgrades and new enhancement option software will be warranted for one
hundred twenty (120) days from the date of initial shipment.
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Disclaimer
The information in this document is carefully examined and is believed to be entirely reliable. However,
no responsibility is assumed for inaccuracies. Furthermore, Motorola Solutions reserves the right to
make changes to any products herein to improve readability, function, or design. Motorola Solutions
does not assume any liability arising out of the applications or use of any product or circuit described
herein; nor does it cover any license under its patent rights nor the rights of others.
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Trademark Information
MOTOROLA and the Stylized M Logo are registered in the U.S. Patent & Trademark Office. All other
product or service names are the property of their respective owners.
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FCC Interference Warning
The FCC requires that manuals pertaining to Class A computing devices must contain a warning about
possible interference with local residential radio and TV reception. This warning reads as follows:

This equipment generates, uses, and can radiate radio frequency energy and if not installed and used
in accordance with the instruction manual, may cause interference to radio communication. This
equipment has been tested and found to comply with the limits for a Class A computing device
pursuant to Subpart J of Part 15 of FCC Rules, which are designed to provide reasonable protection
against such interference when operated in a commercial environment. Operation of this equipment in
a residential area is likely to cause interference. In this case users are required, at their own expense,
to correct the interference.
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EU Class A ITE (EN55022) Warning
This is a Class A product. In a domestic environment this product may cause radio interference in
which case the user may be required to take adequate measures.
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Getting Help
Please read this documentation before using the Elite Dispatch application.

When using the software, Help is available by selecting the Help menu at the top of the screen. If there
is a problem loading the Elite Dispatch application, or if a console does not appear to be working
properly, please refer to any troubleshooting procedures or contact the supervisor.

To request technical assistance, call the Motorola Solutions Support Center at:

• Motorola Solutions Support Center (SSC): (800) 221-7144

• End User or Customer: (800) 323-9949

Please have the following information ready when calling for technical assistance:

• The Customer name and phone number

• The Service Shop or Provider name and phone number

• A description of the problem

• Any remote dial-up numbers (if applicable)

• Serial number of equipment

• CD-ROM number or software version number

• If upgrade, the Factory order number of the upgrade

• Proof of coverage under warranty, maintenance agreement or a valid P.O. number for flat rate
charge
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Contact Us
Motorola Solutions Support Center
The Solutions Support Center (SSC) is the primary Motorola Solutions support contact. Call:

• Before any software reload.

• To confirm troubleshooting results and analysis before removing and replacing a Field Replaceable
Unit (FRU) and Field Replaceable Entity (FRE) to repair the system.

For... Phone

United States Calls 800-221-7144

International Calls 302-444-9800

North America Parts Organization
For assistance in ordering replacement parts or identifying a part number, contact the Motorola
Solutions Parts organization. Your first response when troubleshooting your system is to call the
Motorola Solutions SSC.

For... Phone

Phone Orders 800-422-4210 (US and Canada Orders)

For help identifying an item or part number, select
choice 3 from the menu.

302-444-9842 (International Orders)

Includes help for identifying an item or part number and
for translation as needed.

Fax Orders 800-622-6210 (US and Canada Orders)

Comments
Send questions and comments regarding user documentation to 
documentation@motorolasolutions.com.

Provide the following information when reporting a documentation error:

• The document title and part number

• The page number with the error

• A description of the error

We welcome your feedback on this and other Motorola Solutions manuals. To take a short, confidential
survey on Motorola Solutions Customer Documentation, go to docsurvey.motorolasolutions.com or
scan the following QR code with your mobile device to access the survey.
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About Elite Dispatch User Guide
Provides console operators with information on using the Elite Dispatch software application that
supports the MCC 7500 VPM, MCC 7500E and MCC 7100 Dispatch Consoles.

What Is Covered in This Manual
This manual contains the following chapters:

• Elite Dispatch Basics on page 41

• Elite Dispatch Initial Configuration on page 65

• Configuration Management on page 69

• Radio Communication on page 75

• Phone Communication on page 91

• Elite Dispatch Features on page 97

• Stack Functionality on page 115

• Auxiliary Inputs and Outputs Operation on page 117

• Resource Groups on page 123

• Event Display on page 131

• Troubleshooting on page 139

Helpful Background Information
Motorola Solutions offers various courses designed to assist in learning about the system. For
information, go to http://www.motorolasolutions.com/training to view the current course offerings and
technology paths.

Related Information
See the following documents for associated information about the radio system.

Related Information Purpose

Standards and Guidelines for Communication
Sites

Provides standards and guidelines that should
be followed when setting up a Motorola Solu-
tions communications site. Also known as R56
manual. This document may be purchased by
calling the North America Parts Organization at
800-422-4210 (or the international number:
302-444-9842).

System Overview and Documentation Provides an overview of the ASTRO® 25 new
system features, documentation set, technical
illustrations, and system-level disaster recovery
that support the ASTRO® 25 radio communica-
tion system.
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Chapter 1

Elite Dispatch Basics
The Motorola Elite Dispatch application enables Console Operators to communicate with radio
resources and auxiliary input/output resources ("auxios") and use paging. The Dispatch Operator can
send Call Alerts or Select Calls to a group of resources or communicate with field personnel who do
not have radios by using the paging feature.

1.1
MCC 7500 VPM Dispatch Console Components
The MCC 7500 VPM Dispatch Console consists of the following components:

Footswitch
A transmitting device with two pedals. The right pedal performs the same function as the general
transmit button: initiating transmission to selected resources. The left pedal performs the same
function as the monitor button: disabling the squelch on conventional resources.

Voice Processor Module (VPM)
MCC 7500 VPM Dispatch Consoles include a VPM interface (which replaces the former PCI voice
card, PCI crypto-card, and GPIOM). The Dispatch Console computer is still used to provide audio
commands to the VPM and interface with system operators. The Ethernet interface between the
Console computer and the VPM is used to communicate call processing and resource
management-related information.

Headset
A microphone and speaker that allows operators to communicate with callers and keep their hands
free.

Headset Jack box
A connection device that receives the jack from the headset and has a cable that plugs into the
VPM. The headset jack box also provides volume control for the headset.

Keyboard
The computer keyboard.

Microphone
A voice input device. The desktop microphone typically used with the MCC 7500 VPM Dispatch
Console has a General Transmit button and a Monitor button.

Monitor
A video display.

Mouse (or trackball-type mouse)
A pointing device manipulated by the dispatch software operator.

Personal computer
A computer running Microsoft Windows operating system.

Speakers
The devices through which resource audio is heard. Dispatchers can designate the desired speaker
destinations for audio from selected and from unselected resources.
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1.2
MCC 7500E Dispatch Console Components
The MCC 7500E Dispatch Console is a software-based console that consists of the following
components.

Console Site Control Room Firewall
A control room firewall is used at a console site to ensure secure communications with outside
networks. The PRX 7000 console proxy communicates to remote MCC 7500E Dispatch Consoles
through the control room firewall that allows only for dispatch console-related traffic to and from the
Customer Enterprise Network (CEN).

Desktop Microphone
A voice input device. The microphone typically used with the MCC 7500E Dispatch Console is a
USB gooseneck desktop microphone.

Desktop Speakers
The console is designed to work with the built-in speakers of the host computer, but it also supports
up to eight configurable peripheral speakers. Dispatchers can designate the desired speaker
destinations for audio from selected and unselected resources.

MCC 7500E Dispatch Console
The MCC 7500E Dispatch Console is a software-based dispatch console. To perform dispatch
operations, it requires no external hardware connections such as Voice Processor Module (VPM).
The Windows operating system performs audio vocoding. The keyboard, mouse/trackball, and/or
monitor are native to the computer that hosts the MCC 7100 Dispatch Console software.

Footswitch
A transmitting device with two pedals. The right pedal performs the same function as the general
transmit button: initiating transmission to selected resources. The left pedal performs the same
function as the monitor button: disabling the squelch on conventional resources.

Headset
A microphone and speaker that allows operators to communicate with callers and keep their hands
free. The MCC 7500E Dispatch Console uses a USB headset with PTT.

PRX 7000 Console Proxy
The PRX 7000 console proxy is an application that supports MCC 7500E Dispatch Consoles
deployed outside the ASTRO Radio Network Infrastructure (RNI). It is located at a traditional
console site or in a conventional subsystem. It converts multicast audio packets delivered inside the
ASTRO RNI to unicast audio packets and sends them to the consoles outside the ASTRO RNI. The
PRX 7000 console proxy also maintains links inside the ASTRO RNI on behalf of MCC 7500E
Dispatch Consoles deployed outside the ASTRO RNI. The console proxy can be installed as a
standalone solution or cohabited with the MCC 7500E Dispatch Console.

USB Audio Interface Module
USB Audio Interface Module (USB AIM) connects the Motorola Solutions standard peripherals to
the MCC 7500E Dispatch Console.

1.3
MCC 7100 Dispatch Console Components
The MCC 7100 Dispatch Console is a software-based console that consists of the following
components:

MCC 7100 Dispatch Console
The MCC 7100 Dispatch Console is a software-based dispatch console. To perform dispatch
operations, it requires no external hardware connections such as Voice Processor Module (VPM).
The Windows operating system performs audio vocoding. The keyboard, mouse/trackball, and/or
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monitor are native to the computer that hosts the MCC 7100 Dispatch Console software. For more
information, see the MCC 7100 IP Dispatch Console User Guide.

USB Audio Interface Module
USB Audio Interface Module (USB AIM) connects the Motorola Solutions-standard peripherals to
the MCC 7100 Dispatch Console.

MCC 7100 Console - Speakers
MCC 7100 Dispatch Console is designed to work with the built-in speakers of the host computer,
but it also supports external peripherals. When you use certified commercially available peripherals,
a minimum Delivered Audio Quality (DAQ) of 3.4 is recommended. For more information, see the
MCC 7100 IP Dispatch Console User Guide.

MCC 7100 Console - Microphone
MCC 7100 Dispatch Console is designed to work with the built-in microphone of the host computer,
but it also supports external peripherals. When you use certified commercially available peripherals,
a minimum DAQ of 3.4 is recommended. For more information, see the MCC 7100 IP Dispatch
Console User Guide. If you use the USB AIM, you can connect the desktop microphone provided
by Motorola Solutions.

MCC 7100 Console - Headset
MCC 7100 Dispatch Console is designed to work with a headset component. When you use
certified commercially available peripherals, a minimum DAQ of 3.4 is recommended. For more
information, see the MCC 7100 IP Dispatch Console User Guide. If you use the USB AIM, you can
connect the headset provided by Motorola Solutions.

MCC 7100 Console - Footswitch
MCC 7100 Dispatch Console is designed to work with certified commercially available peripherals.
A minimum DAQ of 3.4 is recommended. For more information, see the MCC 7100 IP Dispatch
Console User Guide. If you use the USB AIM, you can connect the footswitch provided by Motorola
Solutions.

PRX 7000 Console Proxy
The PRX 7000 console proxy is an application that supports MCC 7100 IP Dispatch Consoles
deployed outside the ASTRO Radio Network Infrastructure (RNI). It is located at a traditional
console site or in a conventional subsystem. It converts multicast audio packets delivered inside the
ASTRO RNI to unicast audio packets and sends them to an MCC 7100 IP Dispatch Console
outside the ASTRO RNI. The role of the PRX 7000 console proxy is also to maintain links inside the
ASTRO RNI on behalf of MCC 7100 IP Dispatch Consoles deployed outside the ASTRO RNI.

Console Site Control Room Firewall
A control room firewall is used at a console site to ensure secured communications with outside
networks. The PRX 7000 console proxy communicates to remote MCC 7100 Dispatch Consoles
through the control room firewall that allows only for dispatch console-related traffic to and from the
Customer Enterprise Network (CEN).

1.4
Elite Dispatch Main Window
This figure shows an Elite Dispatch window. The window elements are defined in the list following the
graphic.
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Figure 1: Elite Dispatch Main Window

 Title Bar
Shows the name of the configuration currently open.

 Menu Bar
Displays the menus available in Elite Dispatch.

 Toolbar
Toolbars display shortcut buttons for commonly used menu items and features. The Administrator
configures Toolbar contents.

 Folder Tabs
The resources in a configuration are grouped into folders to simplify desktop organization.
Resources in the selected folder appear on the desktop. To select a different folder, choose its
folder tab. Only one folder can be selected at a time.

 Page Resource
Paging resources are small windows with an Alias name and a QuickPage button.

 Compressed Resource
To conserve screen space, some resources may be compressed. They can be expanded using the
drop-down arrow on the compressed resource. Resources that can be compressed windows are
radio and phone resources.

 Expanded Resource
A resource set up to always display all features. It is locked so the dispatch operator cannot
compress the set of displayed features.

 Auxiliary I/Os or Auxio Resources
These allow control of an external device (such as a door, light, or alarm) monitored by the control
center and display its status, usually on/off or open/close.

 Activity Log
Lists the most recent calls received at the console. The Elite Administrator can disable this optional
display. If enabled, the dispatcher can elect to show or hide the Activity Log.
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 Status Line
Displays status and error messages. To see a list of the most recent messages, select the down
arrow to the right of the status line. To close the list, select the arrow again.

 VU-Meter
Appears in the status line and indicates the audio level of incoming or outgoing audio
transmissions.

 System Status Indicator
Appears in the lower right-hand corner of the Elite desktop if there is a change in system status.

 Event Display Window
Lists events received at the console. The Elite Administrator configures this optional feature. If
enabled, the dispatcher can select to show or hide the Event Display window.

 Compressed Resource (expanded)
When the operator clicks the drop-down arrow of a compressed resource, a flap is displayed which
shows all the features of the resource. Resources that can be compressed windows are radio and
phone resources.

 MultiSelect/Patch Group Window
Displays the Multiselect (MSEL) and Patch folders associated with the selected configuration, and
lists the resources in the currently selected MSEL or Patch folder. If the MSEL or Patch folder
includes a lock icon, the Dispatch Operator cannot edit the resources included in the group.

Related Links

Menu Options on page 46
System Status Indicator on page 140

1.5
VU-Meter
The VU-Meter feature on the MCC 7100, MCC 7500 VPM, and MCC 7500E Dispatch Consoles
provides a visual indication of audio input/output levels. Using the VU-Meter, a Dispatch user can
adjust the volume of the speakers or reposition the microphone for optimal audio levels.

Each Configuration file in the Dispatch application is configured by the Administrator either to show or
hide the VU-Meter information. Depending on your configuration settings, this information is shown in:

• The Status Bar – if your configuration settings do not include the VU-Meter, you see only a place-
holder displayed.

• The Toolbar – the VU-Meter indication can be added to Toolbar 1 or Toolbar 2.

• The VU-Meter Floating Window – a separate window showing VU-Meter indications. Use the View
menu to toggle the display of this window.

The VU-Meter includes up to 11 LED units; 9 green and 2 red. The number of LEDs in the indicator
synchronizes with the loudness of the audio. If the audio level is too low, no LED units are displayed in
the VU-Meter indicator. If the audio is too loud, all 11 LEDs are displayed. A red LED indicates the
audio has exceeded the threshold level.

The icon to the left of the VU-Meter indicates the audio source being measured, either receive audio or
transmit (microphone) audio.

VU-Meter Levels are described in the following list:

VU-Meter at Level 9 for microphone audio
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VU-Meter at Level 9 for receive audio

VU-Meter at Level 10 for microphone audio; the red LED indicates that volume has exceeded the
threshold level

1.6
Menu Options
This section describes the options available in the Elite Dispatch menu bar. The Administrator
configures the drop-down menus of the Elite Dispatch application.

1.6.1
Configuration Menu
The Configuration menu allows the operator to choose one of the configurations set up by the system
administrator.

The Configuration menu contains the following options:

Open
Opens a dialog listing all the configurations available.

Numbered listing
The numbered menu choices listed below the Open option are the last four desktop configuration
files loaded on the console. Users can quickly load one of these configurations by clicking it.

Last Configuration
Reloads the most recently used configuration.

Exit
Exits the Elite Dispatch application.

1.6.2
Edit Menu
The Edit menu allows the Dispatch Operator to temporarily change the configuration of the desktop
and change the audio destinations. Only the System Administrator can make permanent changes.
Changes made by the operator do not remain in effect after exiting Elite Dispatch.

The Edit menu contains the following options:

Folders
Temporarily adds or deletes resources in the currently selected folder.

Audio
Opens the Edit Audio Assignment dialog window allowing changes to the audio heard from each
speaker at the operator position.

Phone Audio
Opens the Edit Phone Audio Assignment dialog window allowing changes to the audio heard
from each speaker at the operator position and ringtones for particular phone lines.

Resource Groups
Opens the Edit Resource Groups dialog window where the Dispatch Operator can edit the
resources for Multiselect groups and Patchgroups and designate Resources as Primary Resources.
If the Edit Resource Groups dialog window for a pre-programmed group displays a check mark in
the Lock Group checkbox, the group cannot be edited by the Dispatch Operator.
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On-Screen Keyboard
If configured in the Elite Admin program, Elite Dispatch offers an on-screen keyboard on the
console monitor that the Dispatch Operator can use for text entry. This keyboard is helpful in
environments where computer keyboards may not be provided. The keyboard can also be
displayed by clicking the button on the Toolbar.

Figure 2: On-screen Keyboard Toolbar Button

Event Display
If the Event Display feature is part of a console system, it allows a dispatcher to edit Event Display
parameters. Editing the Event Display is permitted only if the Administrator configures the feature to
allow modifications by Dispatch Operators.

Preferences
Allows the Dispatch Operator to make limited adjustments to the data presented in the Activity Log.
Dispatch Operators require permission to view the window, so it may not appear if permission has
not been granted.

1.6.3
View Menu
The View menu enables an operator to display the windows for an Activity Log, for an Auxiliary I/O, for
an Event Display, for Group Text Messaging, and for the VU Meter. A check mark next to the menu
item indicates it is visible on the desktop.

NOTICE: Event Display and Group Text Messaging are optional features and are not included
in all systems.

The View menu contains the following options:

Activity Log
Toggles the Activity Log display. If the Activity Log is hidden, this menu option is used to restore the
window.

Auxiliary I/O Window
Toggles the Auxiliary I/O (auxio) Window. If the window is hidden, this menu option is used to
restore the window.

Event Display Window
Toggles the Event Display. If the window is hidden, this menu option is used to restore the display.

Group Text Messaging Window
Opens the Group Text Messaging window. If the window is hidden, this menu option is used to
restore the display.

VU Meter Window
Toggles the VU Meter Window. If the window is hidden, this menu option is used to restore the
window.

Speakers Volume Window
Toggles the Speakers Volume window. If the window is hidden, this menu option is used to restore
the window. Available for MCC 7500E Dispatch Consoles.

1.6.4
Features Menu
The Features menu lists miscellaneous items that are enabled in the loaded configuration.
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NOTICE: The Administrator customizes the menu to suit the needs of each operator position,
therefore your configuration may not include all menu items shown in the following list.

The Features menu contains the following options:

All Mute
Silences all unselected audio for a preprogrammed time period, or until All Mute is deactivated. The
default time period is 30 seconds. When the muting time is complete, the unselected audio returns
to its previous level.

Safety Switch
Allows activation of a safety protected resource within a configurable period of time. This activation
can pertain to safety protected Transmit buttons or Auxiliary I/O. It also allows to select/unselect
safety protected resources or add/remove them to msel/patch groups.

End Audible Auxiliary I/O Alarm
Allows the operator at the console position to reset the indicator (buzzer, bell, or light) associated
with the Auxiliary I/O.

System Status
Opens the System Status dialog.

Secure Operations
Opens the Secure Operations dialog, which allows for the selection of the active secure keyset.
On MCC 7100 Dispatch Consoles and MCC 7500E Dispatch Consoles, it additionally allows for
deleting secure keys.

End Emergency Tones
Discontinues all emergency tones being generated at the console position but does not change the
state of the emergency that triggered the alarm.

Delete Single Stack Entry
Deletes the currently selected stack entry.

Delete Entire Stack
Deletes the entire contents of the stack.

Show/Hide Tool Tips
Toggles on or off the display of the help text that identifies items, such as toolbar buttons.

Clear Status Line
Clears the message in the status line.

1.6.5
Phone Menu
The Phone menu allows the operator to access a dialer keypad for a selected phone resource and
manage active phone calls.

The Phone menu contains the following options:

Dialer
Opens the Dialer keypad in which you manage active calls, dial phone numbers, and view entries

in the shared or local phone book. For the MCC 7500E Dispatch Console a Pause Button  is
available. Use the Pause Button to add one second pauses to phone numbers, when using Dual-
Tone Multi-Frequency (DTMF) systems. The keypad can also be displayed by clicking the dialer
button on the Toolbar.

Hold
Puts on hold a call active on the currently selected phone resource.

Release
Puts on hook the currently selected phone resource.
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Forward/Cancel Forward
Forwards all calls incoming to the dispatch position to another phone number. Opens the Forward
dialog in which the operator specifies the forwarding phone number. Available when call forwarding
is active. Cancels forwarding calls to other consoles.

1.6.6
Folders Menu
The Folders menu allows the operator to switch between desktop folders, temporarily create new
desktop folders, and delete temporary folders.

NOTICE: For information on how to permanently add and delete folders, see the Elite Admin
User Guide online help.

The Folders menu contains the following options:

Add Folder
Temporarily creates a new folder. Up to six folders can be in a configuration.

Delete Folder
Deletes a temporary folder that the operator created, if it is empty.

Numbered listing
The numbered menu lists available desktop folders. Users can quickly switch between folders by
clicking on the items on the list.

1.6.7
Page Menu
The Page menu allows the operator to select resources to send a page.

The Page menu contains the following options:

CheckList
Click to begin a CheckList paging session.

Standard Page
Opens the Standard Page dialog box from which the Dispatch Operator can select Resources to
send a page to.

Send or Resend
Sends the pending pages. Toggles between Send and Resend.

NOTICE: When a page is sent, the Page Resend icon  will appear to indicate a paging

session has been created. The Page Resend icon  is available on the toolbar for you
to resend failed pages. This icon will remain for 20 seconds unless action is taken. During

these 20 seconds, you may resend failed pages. By clicking the Page Resend icon ,
the successful pages are cleared from the paging queue, and a new paging session is
created. The failed pages are then sent again. When this new paging session ends, these
pages are marked as either successful or failed.

Abort
Stops the current paging session.
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1.6.8
Help Menu
The Help menu provides access to the Windows standard online help for the Motorola Elite Dispatch
applications.

The About Motorola <Console Model> Elite Dispatch option displays the copyright date and
version number of the software.

1.7
Toolbar Overview
The toolbar provides quick access to frequently used menu items.

NOTICE: Because the system administrator customizes the toolbar to suit the needs of each
operator position, your configuration may not include the same toolbar items shown here.

This list describes Toolbar icons:

 Activity Log
Shows/hides the Activity Log window.

 Alert Tone
Sends one of the 15 predefined Alert Tones to selected resources.

 Alert Tone (individual)
Sends Individual Alert Tone to selected resources. The buttons can be numbered from 1 to 15.

 All Mute
Silences all unselected audio for a preprogrammed time period or until All Mute is removed. The
default time period is 30 seconds. When the muting time is complete, the unselected audio returns
to its previous level.

 Auxio window
Shows or hides the Auxiliary Input/Output window.

 Delete Single Stack Entry
Deletes the currently selected stack entry.

 Delete Entire Stack
Deletes the entire contents of the stack.

 End Emergency Tones
Discontinues all emergency tones being generated at the console position, but does not change the
state of the emergency that triggered the alarm.

 End Audible Alarm
Allows the operator at the console position to reset the indicator (buzzer, bell, or light) associated
with the auxio.

 General Transmit
Equivalent to pressing the Transmit switch.
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 Group Text Messaging
Opens the Group Text Messaging window, which allows the Dispatch Operator to send text
messages to radio subscribers via trunking talkgroup resources.

 Momentary Override
Allows temporary selection of a voice encryption key and initiates a Push-To-Talk (PTT) function.
Invoking this selection causes the console position to use the selected key for encrypting voice
traffic, and then initiate a transmission in secure mode.

 Monitor
Disables the squelch on currently selected conventional resources, allowing the operator to hear all
audio regardless of the private line code.

 On-Screen Keyboard
Displays a keyboard on the monitor.

 Show/Hide Event Display
Allows the operator to show or hide the Event Display window.

Shows or hides the Speakers Volume window. Available for MCC 7500E Dispatch Consoles.

 Standard Page
Allows the operator to select resources to send a page.

 CheckList
Allows the operator to send a page to selected resources in the main Dispatch window.

 Send Page

Sends a page. Toggles to Page Resend  after a paging session ends.

 Page Resend
Resends a failed page. This icon remains for 20 seconds unless the following actions are taken:

• If you click the Abort Page icon , the Page Resend icon  disappears and the Send

Page icon  becomes available.

• If all the pages in the queue are sent successfully and a new page is added to the queue, the

Page Resend icon  disappears and the Send Page icon  becomes available.

After the 20 seconds have lapsed, the Page Resend icon  disappears and the Send Page

icon  becomes available.
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 Abort Page
Stops the current paging session.

 Safety Switch
Allows the activation of a safety protected resource within a configurable period of time. This
activation can pertain to safety protected Transmit buttons or auxios. It also allows to select/
unselect safety protected resources or add/remove them to msel/patch groups.

 System Status
Opens the System Status dialog.

 Put Phone on Hold
Puts on hold a call active on the currently selected phone resource. Available for MCC 7500 VPM
Dispatch Consoles and MCC 7500E Dispatch Consoles.

 Phone Release
Puts on hook the currently selected phone resource. Available for MCC 7500 VPM Dispatch
Consoles and MCC 7500E Dispatch Consoles.

 Phone Transfer
Opens a window in which a Dispatch Operator specifies a phone number to which the call active on
the resource is to be transferred. The Dispatch Operator can dial the number manually or use the
local or shared phone book. This is an unattended transfer: the call is transferred to the new
number directly, without the Dispatch Operator talking with the party receiving the transferred call.
Available for MCC 7500 VPM Dispatch Consoles.

Attended Call Transfer
Opens a window in which a Dispatch Operator specifies a phone number to which the call active on
the resource is to be transferred. The Dispatch Operator can dial the number manually or use the
local or shared phone book. Attended Call Transfer allows the Dispatch Operator to talk with the
party receiving the transferred call before the call is actually transferred. Available for MCC 7500E
Dispatch Consoles.

Mute Headset Microphone
Allows the Dispatch Operator to mute a phone line so the person on the other end of the phone line
cannot hear the dispatcher, but the dispatcher can still hear the caller. This feature does not affect
dispatcher audio for radio resources and is only available when the Dispatch Operator is using a
headset. Available for MCC 7500E Dispatch Consoles.

 Call Forwarding
Allows the Dispatch Operator to forward all calls incoming to the dispatch position to another phone
number. If you click the button when call forwarding is inactive, it opens the Forward dialog in
which you specify the forwarding phone number. If you click the button when call forwarding is
active, it cancels forwarding calls to other consoles.

NOTICE: Available for MCC 7500 VPM and MCC 7500E Dispatch Consoles.
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 Real-Time Dialing
Allows the Dispatch operator to manage calls, dial phone numbers, and view entries in the shared
or local phone book.

NOTICE: Available for MCC 7500 VPM and MCC 7500E Dispatch Consoles.

   Individual Speaker and Headset Volume Controls
Allows the Dispatch operator to change the volume for the individual third-party speakers and
headset mapped to the dispatch console. A maximum of nine volume controls can be added to the
toolbar — one for the headset and eight for speakers. They are displayed together with the aliases
assigned to them in the .elt file, and support a range of volumes from 1 to 30, where 1 is mute
and 30 is full volume. If an individual speaker or headset volume control is grayed out, no peripheral
is mapped to it.

NOTICE: Available for MCC 7100 and MCC 7500E Dispatch Consoles.

 Enhanced Instant Recall Recorder
Opens the Enhanced Instant Recall Recorder (EIRR) application. Using this application, the
Dispatch Operator can replay specific parts of the audio traffic recorded by the EIRR software on
the dispatch console.

1.8
Activity Log Window Overview
The Activity Log is a floating window that maintains a record of the most recent call activity.

If calls come in to the console too quickly for the operator to answer them, the Activity Log can be used
to quickly contact resources that may have called. The Activity Log is an optional display which can be
disabled by the Elite Administrator.

Figure 3: Activity Log Window

1.8.1
Customizing the Activity Log
Perform this procedure to customize the Activity Log.

Procedure:
1 From the menu, select Edit → Preferences.
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2 In the General Information section of the Preferences window, select the Show Activity Log
check box.

The Activity Log window is now displayed by default.

3 In the Customize Activity Log panel, from the Total Rows drop-down menu, select the number
of rows/entries you wish to see in the Activity Log scrollable list.

4 In the Selected Contents list, select the information you wish to see in the Activity Log by
selecting the appropriate check boxes.

5 Optional: Change the order of the selected content by performing one of the following actions:

• If you wish to move a content category up, select the content type and click the Up arrow.
Click OK.

• If you wish to move a content category down, select the content type and click the Down
arrow. Click OK.

NOTICE: The height of the Activity Log window needs to accommodate the height of an
opened resource tile and any QuickList displayed inside the Activity Log window. As the
window is reduced or expanded in height, it decreases the visible information of those
windows opened inside it.

A preview of the revised column layout is shown at the bottom of the Preferences window.

1.8.2
Responding to Activity Log Entries
The user can select the entries from the Activity Log list and respond to them.

Procedure:
1 Browse the Activity Log entries until the desired call is displayed on the list.

2 In the Activity Log window, select the call.

A view of the selected resource appears above the Activity Log list.

3 Perform operations on the resource as desired.

4 Optional: To change the displayed resource, select another call from the list.

1.9
Page Resource Window
The Administrator configures Page Resources to include specific radios or Auxiliary I/Os.

When a Page Resource is part of a configuration, its member resources receive a page upon activation
of the QuickPage button. Some Page Resources are configured as "safety protected." In that case, a
Dispatcher must use the safety switch button in the toolbar before sending a page.

This list shows the states of a Page Resource during a paging session.

Idle state
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Page started

Page sent successfully

Partial Failure of Page

Full Failure of Page

For more information, see Paging Options on page 85.

Related Links

Paging Options on page 85

1.10
Radio and Phone Resource Windows
Radio Resource and Phone Resource windows are configured in the Elite Admin application, and
can be viewed as expanded or compressed.

NOTICE:
The appearance of radio resources in your system may be different, depending on the features
and the arrangement determined by the Administrator.

Radio resources are available on the MCC 7500 VPM, MCC 7500E, and MCC 7100 Dispatch
Consoles. The Console Telephony feature is available on the MCC 7500 VPM and the MCC
7500E Dispatch Console.

For more information, see Radio Resource Expanded View on page 55, Phone Resource Expanded
View on page 56, and Compressed View on page 57.

1.10.1
Radio Resource Expanded View

NOTICE: When a resource is compressed, a small arrow button next to the resource header
allows you to expand the window. A resource that has been added to a folder in its expanded
mode has no arrow button because it always displays all resource feature buttons.

This image presents the elements in the Radio Resource window in expanded view:
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Figure 4: Radio Resource Expanded View

 Instant Transmit
Press and hold this button to send an Instant Transmit to the resource. Changes to red during
transmission.

 Volume Control
Slide control to increase or decrease the volume of the resource audio. Adjust by dragging the
button left or right.

 Stack
Displays incoming calls to this resource. Calls are listed in chronological order with the newest entry
at the top of the list. See Sending Group Text Messages Using the Stack on page 111 for more
information.

 Micro Help Text
Brief descriptive text displayed as a user moves the mouse over a button or feature on a resource
window.

 Resource Header
Displays up to three lines of information. First line is always the radio name. Lines 2 and 3 are
optional and configured by the Administrator.

 Feature Buttons
Features available for use with a radio resource can be accessed quickly by clicking on the feature
buttons included in the window. The Administrator assigns features to resources.

 Three-line Display
Optional panel on the radio resource and configured by the Administrator. Up to three lines of
information specific to this resource can be displayed.

Related Links

Stack Functionality on page 115

1.10.2
Phone Resource Expanded View

NOTICE: When a resource is compressed, a small arrow button next to the resource header
allows you to expand the window. A resource that has been added to a folder in its expanded
mode has no arrow button because it always displays all resource feature buttons.
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This image presents the elements in the Phone Resource window in expanded view:

Figure 5: Phone Resource Expanded View

 Instant Transmit
Press and hold this button to send an Instant Transmit to the resource. Changes to red during
transmission.

 Volume Control
Slide control to increase or decrease the volume of the resource audio. Adjust by dragging the
button left or right.

 Resource Header
Displays up to three lines of information. First line is always the phone name. Lines 2 and 3 are
optional and configured by the Administrator.

 Micro Help Text
Brief descriptive text displayed as a user moves the mouse over a button or feature on a resource
window.

 Feature Buttons
Features available for use with a radio resource can be accessed quickly by clicking on the feature
buttons included in the window. The Administrator assigns features to resources.

 Three-line Display
Optional panel on the phone resource configured by the Administrator. Up to three lines of
information specific to this resource can be displayed.

1.10.3
Compressed View
To conserve space on the screen, some resource windows can be displayed in their compressed
mode. Although compressing resource windows allows the user to fit more on the screen, it also hides
some information. Resources that have the ability of showing or hiding more information have an arrow
button in the resource header.

This image presents an example of a compressed radio resource window that has been expanded:
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Figure 6: Expanded Area of a Resource Window

1.10.4
Expanding and Compressing Resources Using the Edit Menu
Perform this procedure to expand or compress resources.

Procedure:
1 From the menu, select Edit → Folders.

2 From the Folder menu, select the folder containing the desired resource.

3 Perform one of the following actions:

• To choose a single resource type, from the Type drop-down list, select the appropriate
resource type.

• To choose all resource types, from the Type drop-down list, select All.
4 In the lower right pane, select a resource.

5 Move the resource to the left pane by clicking the Left arrow button.

6 In the left side pane, select the resource.

7 Perform one of the following actions:

• To display the resource in compressed view, select Compressed.

• To display the resource in expanded view, select Expanded.

8 With the resource still selected, return it to the folder by clicking the Right arrow button.

9 To save the changes and close the window, click Close.

1.11
Radio Resource Features
Radio resource features are available to the Dispatch Operator from the feature buttons in the Radio
Resource window. The features for each resource are configured in the Elite Admin application.

This list describes the feature buttons available in the MCC 7500 VPM, MCC 7500E and MCC 7100
Dispatch Consoles:

 Emergency
Allows the Dispatch Operator to quickly respond to an emergency call. When clicked, this button
displays the Emergency QuickList on the operator console.
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 Transmit Mode
Allows the Dispatch Operator to select the transmit mode used for outbound transmissions on a
specific resource.

 Call Alert
Provides an indication on the console position or radio that a call is requested with a specific unit.

 Private Call
Allows to establish private communication between a console position and a radio.

 Volume
Volume control on a resource so that the Dispatch Operator can adjust the audio volume for the
radio. The volume range on the slider is from 0 to 7. If an Administrator configures the minimum
volume to be more than 0, the Dispatch Operator cannot set the volume to be softer than the
minimum volume set by the Administrator.

 Stack
A multi-line stack which displays incoming calls on a resource. The left-hand column displays the
alias or ID of the initiating radio, and the Administrator configure the right-hand column.

 Three-line Display
A three-line display on the resource which may be a feature or text. The Administrator configures
content on each line.

  Priority Select
Toggle this button to switch between Normal Priority (green) and Tactical Priority (red) for this
resource. A dispatch operator may use this feature to assign a higher priority, giving the resource a
better chance of gaining communication access during a repeater busy scenario. Only emergency
calls have a higher priority than tactical.

  Repeater Enabled/Disabled
Toggle this button to allow the audio received from the base station to be repeated to other
subscriber units or whether those received calls are heard only at console positions.

  Console Repeat Enabled/Disabled
Toggle this button to enable and disable the Console Repeat feature. If enabled, the Console
Repeat feature causes the console to key the station. Depending on whether the feature is
configured to work in the normal (non-latched) or latched mode, the console keys the station in one
of the following ways:

• If the feature is in the normal (non-latched) mode, the console keys the station whenever an
inbound radio call is on the channel and causes the inbound audio to be routed to the
transmitter and repeated.
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• If the feature is in the latched mode, the console keys the station as soon as the feature is
enabled and any inbound audio is routed to the transmitter and repeated. It leaves the station
keyed even when no inbound radio audio is on the channel. The station is not dekeyed until the
feature is disabled. Scanners remain on that channel as long as the carrier is present and
people near the scanners hear all the activity on that channel without interruption due to
scanning other channels. These scanners are typically used by public safety officials that are
listening to the radio traffic associated with a particular event.

The feature can be pre-configured to be automatically disabled after a predefined time. Before it
happens, a timeout warning appears in the status line at the bottom of the Elite Dispatch window.
The automatic disablement is postponed if an inbound radio call is active when the feature is about
to be disabled. In this case, the feature is disabled when the inbound radio call ends.

 Frequency Select
If a resource is equipped with multiple frequencies, the desired frequency can be selected from the
frequency select drop-down list.

  Secondary Receiver Muted/Unmuted
Some radios are equipped with a talkaround switch that allows them to transmit to each other
without going through the system repeaters. Consoles may have a secondary receiver tuned to the
talkaround frequency, allowing the operator to hear talkaround conversations at the console.
The Mute Secondary Receiver feature allows the operator to mute the receiver tuned to the
talkaround frequency so talkaround conversations cannot be heard at the console.

 Remote Monitor
Remotely commands a radio to key-up its microphone and transmit for a short period of time. It is a
listen-only mode and the radio shows no indication that it is transmitting. The feature is used if a
radio is stolen or if the user is not responding to calls.

 Radio Check
Checks if the subscriber unit is functioning on a resource, without causing interruption to the
specific unit. It can be used as a routine preventive maintenance check or as a specific action,
when the operator has some reason to doubt the availability of the unit.

 Radio Enable/Disable
Enables or disables the subscriber unit remotely. It can be used to disable a stolen or lost unit or to
enable a previously disabled unit.

 Status Request
Remotely interrogates a subscriber unit and obtains its current status.

 Voice Sel Call
Communicates with a single console or radio unit without having other units on the same channel
listening to the conversation. It eliminates the annoyance of users having to listen to traffic that has
nothing to do with them.
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  Channel Marker Available/Activated
Activates a channel marker button on a resource to identify a channel as priority and to warn non-
critical radio users not to transmit. All parallel Dispatch consoles see an activated channel marker
and any operator position can deactivate it.
A single operator position is permitted to activate up to 5 channel markers.

 Private Line Select
If a resource is equipped with Private Line capability, the desired Private Line can be selected from
the drop-down list.

  External Controller Enabled/Disabled
Known as Takeover, this feature allows an operator to take over or cease the communications
being initiated from a remote console. The Takeover Switch inhibits or permits the circuit used by
these remote positions to communicate with the system. By default, the circuit allowing the remote
console to operate is enabled.

 Outbound Secure Key
Available for digital conventional and analog conventional resources. Allows a Dispatcher to select
from a list of encryption keys for secure transmission.

  Wildcards 1 and 2
Similar to the Auxiliary I/O controls, Wildcards can be used to toggle the state of an external control
at a base station.

   Main/Alternate Channel control
Allows a Dispatcher to choose which channel is active for a conventional site. The Main/Alternate
button may appear on the resource in one of three states: Main channel active, Alternate channel
active, Main/Alt state Unknown. (The default button states are shown here.)

   Channel-associated Public Auxiliary I/O
An Auxiliary I/O button may appear on the resource in one of three states: Inactive, Active, or
Unknown (the default button states are shown here.)
If the Aux I/O is safety protected, the  icon appears at the top left side of the Inactive state button.

 Group Text Messaging
Opens the Group Text Messaging window, which allows the Dispatch Operator to send text
messages to radio subscribers via trunking talkgroup resources.

 Resource not available indicator and  Resource partially available indicator
The resource status feature is used to inform the operator of the availability of a resource. When
the resource becomes fully functional, the indicator is removed.
For channels capable of analog or digital operation, the partially available indicator means that
analog communication on the channel is unavailable; only digital mode communications are
available while the resource is in this state.
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1.12
Phone Resource Features
Phone resource features are available to the Dispatch Operator from the feature buttons in the Radio
Resource window. The features for each resource are configured in the Elite Admin application.

The following list describes the feature buttons available in the MCC 7500 VPM and MCC 7500E
Dispatch Consoles:

 Volume
Allows the Dispatch Operator to adjust the audio volume for the phone. The volume range on the
slider is from 0 to 7. If an Administrator configures the minimum volume to be more than 0, the
Dispatch Operator cannot set the volume to be softer than the minimum volume set by the
Administrator.

 Phone Hold
Puts on hold the call active on the resource.

 Phone on Hook
Ends a call in progress and puts the phone resource on hook. You can also use it to put a selected
phone resource on hook when no call is active on it. For example, after you select the resource for
dialing, you choose to cancel the dialing operation.

 Phone Transfer
Opens a window in which a Dispatch Operator specifies a phone number to which the call active on
the resource is to be transferred. The Dispatch Operator can dial the number manually or use the
local or shared phone book. This is an unattended transfer: the call is transferred to the new
number directly, without the Dispatch Operator talking with the party receiving the transferred call.
Available for MCC 7500 VPM Dispatch Consoles.

Attended Call Transfer
Opens a window in which a Dispatch Operator specifies a phone number to which the call active on
the resource is to be transferred. The Dispatch Operator can dial the number manually or use the
local or shared phone book. Attended Call Transfer allows the Dispatch Operator to talk with the
party receiving the transferred call before the call is actually transferred. Available for MCC 7500E
Dispatch Consoles.

Mute Headset Microphone
Allows the Dispatch Operator to mute a phone line so the person on the other end of the phone line
cannot hear the dispatcher, but the dispatcher can still hear the caller. This feature does not affect
dispatcher audio for radio resources and is only available when the Dispatch Operator is using a
headset. Available for MCC 7500E Dispatch Consoles.

 Three-Line Display
A three-line display on the resource which may be a feature or text. The Administrator configures
the content on each line.
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 Resource not available indicator and  Resource partially available indicator
The resource status feature is used to inform the operator of the availability of a resource. When
the resource becomes fully functional, the indicator is removed.
For phone resources, the partially available indicator means that only one of the two available
telephony media gateways answered and communication on the resource is probable to be
rejected.
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Chapter 2

Elite Dispatch Initial Configuration
This chapter contains basic configuration procedures to allow the Dispatch Operator to begin work with
the Elite Dispatch Console.

2.1
Starting Elite Dispatch
Perform this procedure to start the Elite Dispatch application.

Prerequisites: MCC 7500, MCC 7500E and MCC 7100 products support only locally stored
configuration files. All remote configuration files should be copied locally prior to opening, otherwise
longer startup times occur.

Procedure:
1 From the Start menu, select All programs → Motorola → Motorola MCC 7x00 → Elite

Dispatch.

2 Select the configuration to be loaded. Click Open.

3 Perform one of the following actions:

• For standard sign-on with a physical keyboard, enter your username and password. Click
OK.

• For standard sign-on with the on-screen keyboard, click the Keyboard button and use the
on-screen keyboard to enter your username and password. Click OK.

Figure 7: The On-screen Keyboard

• For domain-based single-sign on, click OK.

4 If the entered credentials are accepted, the database status is checked.

• If the system database was updated since the last time the console was started, and the
console is not set up to auto-authenticate, an New Database Exists dialog box appears.

• If the system database was updated since the last time the console was started, and the
console is set up to auto-authenticate, the Database Synchronization message appears
without any user intervention.

5 If the New Database Exists dialog box appears, perform one of the following actions:

If… Then…

If you wish to
update the da-
tabase with the
new informa-
tion,

perform the following actions:

a Click Yes.
An information dialog box appears while synchronization is in pro-
gress.
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If… Then…

b Optional: Click the Shutdown button to cancel the synchronization
process.
A confirmation dialog box is displayed.

c Perform one of the following actions:

• To shut down the application, in the confirmation dialog, click Yes.

• To resume database synchronization, in the confirmation dialog,
click No.

If you wish to
use the old da-
tabase and
continue start-
up,

perform the following actions:

a Click No.
If a new database becomes available while Elite Dispatch is running,
the following message appears in the status line:
A new database exists, please restart the applica-
tion to use it.

b Optional: If the previously described message is displayed, restart
Elite Dispatch.

The Elite Dispatch window opens.

2.2
Exiting Elite Dispatch
Perform this step any time you want to close the Elite Dispatch application. Exit the Elite Dispatch
application any time you shut down or restart the operator position workstation, or switch between the
Windows operating system accounts on the operator position.

Procedure:
1 In the Elite Dispatch window, from the Configuration menu, click Exit.

When minimizing or exiting Elite Dispatch application, you may be prompted for a password, if
such requirement has been set by the administrator. Type in the password using computer
keyboard or on-screen keyboard.

NOTICE: Password required for minimizing or exiting Elite Dispatch application may be
different than the application password.

Exiting Elite Dispatch removes all resources from the Multiselect and Patch groups and ends all radio
transmissions from the console.
If unacknowledged emergencies are present during a shutdown or while changing to another
configuration without restarting Elite Dispatch, a message appears and prompts for a confirmation.

If an operator position is disabled or otherwise shuts down before a console-initiated emergency is
knocked down, that console-initiated emergency is knocked down from all other operator positions
monitoring the channel on which the emergency was engaged.

2.3
Monitoring a Channel
The Monitor button allows a dispatch operator to listen to everything on a channel and avoid
overriding another transmission in progress.
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Procedure:
1 Click and hold the Monitor button on the toolbar or hold down the left footswitch pedal.

This momentarily disables the squelch on the resource so the operator can listen to
transmissions on other private lines.

2 If no one else is speaking, perform a transmission to the resource.

2.4
System Clock
The clock can be optionally displayed to the right of the top toolbar and is automatically synchronized
with the console Windows domain controller. The format of the clock display can be modified in the
Regional Settings of the Windows Control Panel.

IMPORTANT: Do not set the clock manually.
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Chapter 3

Configuration Management
Each console operator position consists of an arrangement of on-screen resources and features. They
exist as computer files called configuration files. Any changes to a configuration made by Dispatch
Operators are temporary and remain in effect only until the operator exits Elite Dispatch.

3.1
Opening Configurations
Several options of opening configurations are available in the Configuration menu.

Opening a new configuration automatically closes the current one, which in turn closes all Multiselect
and Patch groups.

Procedure:
From the Configuration menu, select one of the following options:

If… Then…

If you want to select from the
list of all available configura-
tion files,

perform the following actions:

a From the menu, select Open.

b Scroll to the configuration that you want to open.

c Select the configuration and click Open.

If you want to select from the
last four desktop configura-
tion files loaded on the con-
sole,

perform the following actions:

a From the menu, view the list of the four most recent
configuration files used. The list is available directly
underneath the Open option.

b Select the configuration you want to open with the
mouse and press ENTER.

If you want to open the con-
figuration used most recent-
ly,

select Last Configuration from the menu.

3.2
Adding Folders to Configurations
A configuration can contain up to 20 folders and only the system administrator can make permanent
changes to the configuration files. Temporary folders that operators create are deleted when Elite
Dispatch is exited. To remind the operator that the folders are not permanent, they are automatically
named Temporary <n>, where <n> is a number.

Prerequisites: To add folders to a configuration, open a configuration first. See Opening
Configurations on page 69.

Procedure:
From the menu, select Folders → Add Folder.

A folder named Temporary <n> appears on the desktop.
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3.3
Deleting Folders from Configurations
The operator cannot delete folders set up by the system administrator. However, temporary folders
created by the operator may be deleted.

Procedure:
1 Select the folder tab of the temporary folder to be deleted.

2 From the menu, select Edit → Folders.

3 In the Edit Folder Resources window, from the Folder drop-down list, select the folder you
want to delete.

The resources in the temporary folder are listed in the right-side pane.

4 Select a resource and remove it by clicking the left arrow button.

5 Repeat step 4 for all the resources in the folder

6 Click Close.

7 Click the tab of the temporary folder you want to delete. From the menu, select Folders →
Delete Folder.
• If the Delete Folder button is active, click it to delete the folder.

• If the Delete Folder button is grayed out, go back and make sure all resources in the folder
have been deleted.

The folder tab is removed from the desktop.

3.4
Adding Resources to Folders
The Dispatch Operator can organize resources by adding them to selected folders.

Procedure:
1 From the menu, select Edit → Folders.

2 In the Edit Folder Resources window, from the Folder drop-down list, select the folder to which
you want to add resources.

3 From the Type drop-down list, select the type of resources you want to display.

Available resources are listed in the left-side pane. Resources of the selected type present in the
selected folder are listed in the right-side pane.

4 In the left-side pane, click on a resource you want to add and click the right arrow button. Repeat
this for all the resources you want to add to the current folder.

5 To set the display size of a resource in the folder, select the resource and click one of the
following radio buttons:

• To display the resource window without including its features, click Compressed.

• To display the resource window including all its features, click Expanded.

6 Optional: Resize the resource to 2x or 3x the default size by choosing one of the options from
the Size drop-down list.

7 Set the audio route for a resource by selecting the resource and choosing an option from the
following drop-down menus:

• To choose the speaker to use for this resource Select audio, choose Select.
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• To choose the speaker to use for this resource Unselect audio, choose Unselect.
• To set a value for the audio volume, select Volume. If the resource is included in another

folder with different audio settings, changing the volume here changes all current audio
settings.

• To display the emergency tone configuration for the resource, select Emergency Tone.

8 Optional: If you want the Select audio routed to your headset, from the Headset Behavior drop-
down list, choose one of the following options:

• To hear the Select audio only through your headset, choose Use headset for select.
• To hear the Select audio through your headset and through the Select speaker, choose Use

headset & speaker for select.
NOTICE: If one of these options is selected and the headset is not plugged into the
headset jack box, the audio defaults back to the resource Select speaker.

9 When finished, click the Close button.

3.5
Adding Speed Dials to Folders
Speed Dials are resources that can be added to folders. They allow dispatch operators to dial a
specific phone number with one click. You can create speed dials only from the local phone book and
the shared phone book entries.

Prerequisites: Ensure that your local phone book or shared phone book contains the required speed
dial phone number.

Procedure:
1 From the menu, select Edit → Folders.

2 From the Folder drop-down list, select a folder to which you want to add speed dials.

3 From the Type drop-down list, select the Speed Dial option.

Available speed dials are listed in the left-side pane. Speed dials present in the selected folder
are listed in the right-side pane.

4 From the left-side pane, select a speed dial you want to add to the folder.

5 Move the speed dial by clicking the right arrow button.

6 When finished, click the Close button.

Related Links

Initiating Phone Calls from Phone Books on page 92
Initiating Phone Calls on page 91

3.6
Removing Resources from Folders
The Dispatch Operator can remove unnecessary resources from folders.

Procedure:
1 From the menu, select Edit → Folders.

2 From the Folder drop-down list, select a folder from which you want to remove resources.

3 From the right-side pane, select a resource. Click the left arrow button.
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4 When finished, click the Close button.

3.7
Adjusting the Resource Volume
When the operator selects a resource, the audio of that resource increases to full volume. To
temporarily increase or decrease the volume of a resource, adjust the volume control on the resource.

Procedure:
1 Optional: Expand the resource by clicking the down arrow button.

2 Adjust the volume by performing one of the following actions:

• Slide the volume control in either direction to adjust the volume.

• If you have volume knobs on your speakers, use them to adjust the overall volume of each
speaker.

NOTICE: The volume range on the slider is from 0 to 7. If an Administrator configures the
minimum volume to be more than 0, the Dispatch Operator cannot set the volume to be
softer than the minimum volume set by the Administrator.

The Microhelp line at the bottom of the resource window displays the new volume setting.

Related Links

Adjusting the Resource Volume with Volume Sliders on page 72

3.8
Adjusting the Volume through the Speakers Volume Window
This window allows you to easily adjust the volume of the console speakers and headset. The list of
available devices and their default volume level are configured by the administrator in the Elite Admin
application.

Procedure:
1 From the menu, select View → Speakers Volume Window.

2 Adjust the volume of the chosen speaker or headset by sliding the volume control in the
appropriate direction.

3 Repeat step 2 for each device on which you need to adjust the volume.

3.9
Adjusting the Resource Volume with Volume Sliders
The initial volume depends on the configuration of the administrator. Use volume sliders available on
the console toolbar to adjust the overall volume of the console speakers and headset.

NOTICE: Volume sliders are available for MCC 7100 and MCC 7500E Dispatch Consoles. The
maximum number of volume sliders added to the toolbar is nine (one for the headset and eight
for speakers).

Procedure:
1 On the toolbar, find the required volume slider.

2 Slide the volume control in either direction to adjust the volume.
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3.10
Assigning Audio Destinations for Radio Resources
The Dispatch Operator can designate through which speaker specific audio is heard and whether a
resource Select audio should be routed to the headset.

Procedure:
1 From the menu, select Edit → Audio.

2 In the Assigned Resources list, select the resource for which you want to assign audio
destinations.

3 In theSelect drop-down list, choose a destination where a resource audio is heard when the
resource is selected.

4 In the Unselect drop-down list, choose a destination where a resource audio is heard when the
resource is not selected.

5 In the Emergency Tone drop-down list, select an Emergency Tone configuration for the
resource.

6 If you want the Select audio routed to your headset, from the Headset Behavior drop-down list,
choose one of the following options:

• To hear the Select audio only through your headset, choose Use headset for select.
• To hear the Select audio through your headset and through the Select speaker, choose Use

headset & speaker for select.
NOTICE: If one of these options is selected and the headset is not plugged into the
headset jack box, the audio defaults back to the resource Select speaker.

7 Save changes and close the window by clicking OK.

3.11
Assigning Audio Destinations for Phone Resources
The Dispatch Operator can change the speakers through which audio for specific active phone calls is
heard.

NOTICE: You can change the settings only for active phone calls. The settings are temporary
and they revert to the saved configuration after the phone call ends.

Procedure:
1 From the menu, select Edit → Phone Audio.

2 In the Active Phone Calls list, click on an active call.

3 From the Select drop-down menu, select the speaker for the active phone call on a selected
phone resource.

4 From the Unselect drop-down menu, select the speaker for the active phone call on an
unselected phone resource.

5 Save changes and close the window by clicking OK.

3.12
External Resource Assignments
An External Resource Assignment is an assignment of a resource that is not initiated by Elite Dispatch.
Externally assigned resources (such as one initiated by a CAD application) can be used as any other
resource after you place them in the External Assignment Folder.
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NOTICE: External assignments can cause the Elite Dispatch application to add temporary
folders to a configuration.

The External Assignments operate according to the following placement pattern:

1 Upon receiving an External Assignment, the Elite Dispatch application attempts to place the
resource in a viewable area of the External Assignment Folder. This folder is one of the folders on
the desktop which has been designated by the Administrator using the Elite Admin application.

If the Elite Dispatch application window has been resized, parts of the folders may be obscured.
The remaining areas are referred to as the viewable areas of the folders.

2 If the resource cannot be placed in the viewable area of the External Assignment Folder, the Elite
Dispatch application attempts to place the resource in the viewable area of the next folder to the
right of the External Assignment Folder.

3 If a folder does not exist to the right of the External Assignment Folder and there is room to add a
folder, a new folder named Temporary <n> is created.

4 The Elite Dispatch application continues to fill the viewable area of each folder to the right. If there is
no room to add folders, the resource is placed on the first (left-most) folder in its viewable area.

5 If there is no room in the visible area for the complete resource, the Elite Dispatch application
places resources in the remaining areas of the folders, moving to the next folder to the right each
time a folder becomes full. After it reaches the last folder, it wraps around to the first folder and
continues placing resources in the remaining areas until all folders are full. If a resource is not fully
visible, a warning message is displayed on the status line.

6 If the Elite Dispatch application receives an External Assignment when all the folders are full, the
resource has been assigned but cannot be seen or controlled by the Elite Dispatch application. A
warning message is displayed on the status line.
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Chapter 4

Radio Communication
The Motorola MCC 7500 VPM, MCC 7500E and the MCC 7100 Dispatch Consoles allow the
dispatcher to monitor and communicate with radios. The Activity Log is a floating window that
maintains a record of the most recent call activity received on a console. If calls come into the console
too quickly for the operator to answer them, the Activity Log can be used to quickly contact users who
may have called.

CAUTION: If the Elite Dispatch application is minimized or resized so that resources are no
longer visible, the operator risks missing inbound call activity. Motorola Solutions assumes no
liability for the consequences of such missed calls.

The Motorola MCC 7500 VPM, MCC 7500E and the MCC 7100 Dispatch Consoles support the
following types of radio communication: transmitting (group and individual), receiving, and paging/stat-
alert signaling.

4.1
Radio Transmission
The Dispatch Operator can communicate with other Resources by transmitting to them from the Elite
Dispatch Console.

4.1.1
Resource Transmit Statuses
Resource Transmit Status is a console feature that informs the console position about the transmit
state of each resource. The information appears as the status icon in the resource header.

When a console operator tries to transmit by using any of the available transmit features, for example,
General Transmit, APB Transmit, or Instant Transmit, the console attempts to transmit on each of the
affected resources. The system returns information regarding the status of each of the affected
resources to the console operator.

Some resource transmit status messages are not limited to the console position that attempts to
transmit. A parallel console position that attempts to transmit also causes these messages to be sent
to all console positions that are assigned to or monitor that same resource.

This console position is transmitting on this resource.

The resource is busy.

This icon stands for one of the following statuses:

• No repeaters ARE available for the requested transmission. The radio system has queued the
transmit request to wait for the next repeater.

• The system does not have bandwidth to grant the transmission request.

• The transmit operation is being initiated.

 (blinking)
Repeater now available for this resource, so the console operator can now transmit.
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The resource is currently busy but the audio cannot be routed to this console position.

The resource is currently cross-busied due to a console transmission. The dispatcher can attempt
to override another console that is using RF resources shared with this resource.

The resource is currently cross-busied due to a subscriber in emergency transmission that is using
RF resources shared with this resource. A console transmission breaks the repeat path of an
emergency call.

The resource is cross-busied due to a subscriber non-emergency transmission that is using RF
resources shared with this resource. A console transmission breaks the repeat path.

No Icon
No Icon stands for one of the following statuses:

• No console position is transmitting on this resource.

• Resource is busy sending data, no transmit audio is to be heard.

Some transmit status messages appear for parallel consoles. Other messages are sent to the console
positions that attempt to transmit.

These transmit statuses are sent to all operators who monitor this resource:

•

•

•

• No Icon

This transmit status is sent to all operators who monitor this resource and have no audio path
available:

•

These radio cross busy transmission statuses are sent to all operators who monitor this resource:

•

•

4.1.2
Transmission Priorities
Supervisor transmissions take priority over transmissions by other operators. Therefore, the supervisor

can take control of a resource from an operator with lower priority. The Instant Transmit button 
allows the supervisor to access any resource immediately, regardless of other operator activity on that
channel.

When the supervisor takes control of a channel from another operator, audio is heard from the
speakers at all operator positions not acoustically cross-muted.
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In dispatch centers with a secondary supervisor, the primary supervisor still has highest priority, but
secondary supervisors have a higher priority than non-supervisors.

This table outlines transmission priorities:

Table 1: Transmission Priority Outline

Priority
Level

Primary Supervisor Secondary Supervisor Operator (non-supervi-
sor)

1 Instant Transmit, APB

2 Instant Transmit, APB

3 Instant Transmit, APB

4 General Transmit General Transmit General Transmit

5 Patch Transmit Patch Transmit Patch Transmit

4.1.3
Group Transmission
This list describes transmission methods and features available to a Dispatch operator:

General Transmit
Allows the operator to talk on the selected resources using a toolbar button, button on the
microphone, or footswitch.

Instant Transmit
Allows the operator to talk on a single resource, whether that resource is selected or not.

Safety Instant Transmit
Prevents a Dispatch operator from accidentally transmitting on important resources by requiring to
activate a safety switch prior to sending an instant transmit

Multiselect/Patch Transmit
Allows the operator to transmit on multiple resources simultaneously.

Clear Audio Alert
If a secure-only console has been configured in Elite Admin to provide Clear Audio indications, the
console generatee a Clear Audio Alert tone and displays the Clear Audio Transmit Indicator on a
resource transmitting clear audio.

Frequency Select
Allows a Dispatch operator to transmit on a resource equipped with multiple frequencies. Select the
frequency to transmit on from the Frequency drop-down list prior to transmitting on the resource.

Transmit Mode Select
Allows a Dispatch operator to select the transmit mode used for outbound transmissions on a
specific resource. The transmit mode indicates whether transmissions are encrypted to prevent
eavesdropping by unintended listeners.

Outbound Secure Key
Allows the Dispatch operator to select from a list of encryption keys for the purpose of secure
transmissions. The feature is available for digital conventional and conventional resources.

Priority Select: Tactical/Normal
Allows a Dispatch operator to select the relative system access priority of a resource in its
communication system.

Taking Control from Another Operator Position
Allows a Dispatch operator to take control of a resource away from another operator position if its
transmit mode is a higher priority.
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Related Links

Sending APB and Patch Transmits on page 130
Sending Safety Instant Transmits on page 79
Sending General Transmits to Multiselect Groups on page 129

4.1.4
Safety Single Resource Select
You may have to activate a safety switch before performing single select on a radio or paging
resource, if such requirement has been set by the system Administrator.

Procedure:

1 From the toolbar, select the Safety Switch  button, so it turns green .

2 Select the desired single Resource.

NOTICE: You have to select Safety Switch button every time you want to select a single
Resource

4.1.5
Sending General Transmits
General transmit allows the operator to talk on the selected radio resources. Anyone monitoring the
same resources may also hear the transmission.

Prerequisites: If a resource is part of a simultaneous paging session, the General Transmit button
shows whether a general transmission can occur. A voice transmission cannot proceed until a paging
session (and any resends) has ended or been aborted.

Procedure:
1 Select the radio resources to transmit on.

The selected resource appears with a white background and a green border.

2 To avoid overriding another transmission in progress on resources using Private Line, perform
one of the following actions:

• Select the Monitor button  on the toolbar.

• Hold down the left footswitch pedal.

The squelch on the resource is temporarily disabled so the Dispatch Operator can listen to
transmissions on other private lines.

3 If no one else is speaking, perform one of the following actions:

• Transmit and speak into the microphone by holding down the Transmit button on the toolbar
or microphone.

• Transmit and speak into the microphone by pressing the right footswitch pedal.

The red transmit icon appears on the selected resource.

4 When done transmitting, perform one of the following actions:

• Release the Transmit button.

• Release the right footswitch pedal.
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Related Links

Sending APB and Patch Transmits on page 130
Sending General Transmits to Multiselect Groups on page 129

4.1.6
Sending Instant Transmits
Use Instant Transmit when you want to transmit to a resource, but not change the resource selected,
or when you want to try to override an existing conversation.

Procedure:
1 To avoid overriding another transmission in progress on resources using Private Line, perform

one of the following actions:

• Select the Monitor button  on the toolbar.

• Hold down the left footswitch pedal.

The squelch on the resource is temporarily disabled.

2 Transmit and speak into the microphone by holding down the Transmit button on the resource.

The red transmit icon appears on the resource.

3 Release the Transmit button when done transmitting.

4.1.7
Sending Safety Instant Transmits
The system Administrator may have set up some radio or paging resources so that the operator must
first activate a safety switch before performing an instant transmit. This system prevents the operator
from accidentally transmitting on important resources.

Procedure:

1 From the toolbar, select the Safety Switch button .

The Safety Instant Transmit button  on the resource changes to the regular Instant

Transmit button .

2 Click and hold the Instant Transmit button for five seconds.

3 Speak into the microphone.

4 When done transmitting, release the Instant Transmit button.

4.1.8
Transmit Mode Select
Transmit mode is a feature that permits the operator to select the transmit mode used for outbound
transmissions on a specific resource. The transmit mode indicates whether transmissions are
encrypted to prevent eavesdropping by unintended listeners.

This figure shows the possible modes of operation displayed:
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Figure 8: Transmit Modes Available to a Dispatch Operator

To change the transmit mode of the resource, click the Transmit Mode Select button.

4.1.9
Selecting a Private Line
If a resource is equipped with Private Line capability, the desired Private Line can be selected from the
Private Line drop-down list prior to transmitting on the resource.

Procedure:

From the Private Line  drop-down list, select the desired private line.

4.1.10
Sending Outbound Secure Key Transmissions
Outbound Secure Key permits the dispatch operator to select from a list of encryption keys for the
purpose of secure transmissions. The feature is available for digital conventional and conventional
resources.

Procedure:
1 Select the radio resource to transmit on.

2 Set the resource to a coded transmit mode.

3 From the Secure Key drop-down list on the resource, select the desired outbound secure key.

Figure 9: Outbound Secure Key Drop-down List

4 To begin the secure transmission, click and hold the Transmit button.

5 To end the secure transmission, release the Transmit button.
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4.1.11
System Access Priority Select
System Access Priority Select allows a Dispatch operator to select the relative system access
priority of a resource in its communication system. A Dispatch operator may use this feature to assign
a higher priority to the associated resource, giving the resource a better chance of gaining
communication access during a repeater busy scenario.

During a repeater busy scenario, if two call requests are queued with one as normal and the other as
tactical priority, the one with the tactical priority gains access to the system when the next repeater
becomes available.

NOTICE: Only emergency calls have a higher priority than tactical.

This list describes the states of the Priority Select toggle button:

System Access Priority is set to Tactical.

System Access Priority is set to Normal.

Click the Priority Select button until the desired System Access Priority is set.

Related Links

Setting System Access Priority

4.1.12
Control Transfer from Another Operator Position
An operator position can take control of a resource away from another operator position if its transmit
mode is a higher priority.

NOTICE: Transmission by a supervisor console user has a higher priority than a transmission
from a non-supervisory user. If the supervisor takes control of a resource while another operator
is transmitting on it, the supervisor audio may be heard from the speakers of the non-supervisor
console.

This list describes the available transmit priorities:

High Priority
All-Points Bulletin (APB)

Instant Transmit. If a yellow lightning bolt appears in the indicator area of a resource, another
operator is transmitting to it. The operator can either wait until the other call is finished, or attempt to
interrupt the transmission using Instant Transmit.

Medium Priority
General Transmit

Footswitch Transmit

Multiselect Transmit

Low Priority
Patch Transmit
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4.1.13
Transmitting on Resources with Multiple Frequencies
If a resource is equipped with multiple frequencies, the Dispatch operator can select the appropriate
frequency.

Procedure:

From the Frequency drop-down list , select the desired frequency prior to
transmitting on the resource.

4.1.14
Private Calls
Use the Private Call feature to establish private communication between a console position and a
radio. Only one private call per console is supported. Private calls are indicated by a solid green circle
displayed on the Private Call button. The circle blinks until the call is answered.

Figure 10: Private Call Button

The message Private Call appears in the Resource header and in the stack. The audio from the
transmitting radio is heard immediately through the console. Depending on how the system is
configured, a series of tones may also be heard through the console. Private call indications continue
until the call is answered by the Dispatch console operator.

When the target radio answers the call, click and hold the Transmit button to talk to the radio.

If there is no audio activity over a period of time, the call ends and all call indications are removed from
the Resource if the system is configured as such.

Related Links

Initiating Private Calls on page 83
Receiving Private Calls on page 82

4.1.14.1
Receiving Private Calls
When a resource initiates a private call, you receive it on the console position.

Procedure:
1 On the resource displaying the Private Call message, click Private Call.

The resource is taken off-hook and the blinking green circle becomes solid.

2 Talk to the radio by clicking and holding Transmit.
3 End the call by clicking Private Call.

Related Links

Initiating Private Calls on page 83
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4.1.14.2
Initiating Private Calls

Procedure:
1 On the Resource, open the Private Call QuickList by clicking the Private Call button.

2 Select an ID and click the Send button.

3 Click the Transmit button.

A solid green circle appears in the upper-left hand corner of the Private Call button and the
message Private Call appears in the Resource header. The target radio receives an
indication that the transmission has begun.

4 To end the Private Call, click the Private Call button.

NOTICE: A full duplex private call differs from a simplex individual call in that audio flows
concurrently in both directions; that is, the user can both receive and transmit at the
same time. A full duplex call is indicated by the double-ended arrow over the private call
icon.

Related Links

Receiving Private Calls on page 82
Outbound Signaling with the QuickList on page 100

4.1.15
Alert Tones
Use the Alert Tone feature to send a predefined tone to a radio or console position. A Dispatch
Operator can send one of 15 predefined tones to a radio or console. Alert tones are a consistent
means of notifying radios or consoles of a certain condition.

An alert tone cannot be sent to a receive-only resource or at the same time as any of the following
transmissions:

• Another Alert Tone

• A General Transmit

• A Patch Transmit

• A Page

• An APB Transmit

The two types of alert tones are configured by an Administrator in the Elite Admin application. The alert
tones can be one of the following types:

Momentary alert tones
Alert tones are sent only when you press the Alert Tone button on the toolbar.

Latched alert tones
Alert tones are sent for a predefined period of time after you press the Alert Tone button on the
toolbar. To stop sending the latched alert tone before the predefined time ends, press the Alert
Tone button again.

Related Links

Sending Alert Tones on page 84
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4.1.15.1
Sending Alert Tones
Perform this procedure to send alert tones.

Procedure:
1 In the Elite Dispatch window, select the resources you wish to send the alert tone to.

2
From the drop-down list in the Alert Tone Select button  on the toolbar, select one of
the 15 predefined tones.

NOTICE: If the Alert Tone Select button is not available on the toolbar, use the

individual Alert Tone button .

3 Perform one of the following actions:

• To send a momentary alert tone, click and hold the Alert Tone Select button for as long as
you wish to send the alert tone.

• To send a latched alert tone, click the Alert Tone Select button.

Related Links

Alert Tones on page 83

4.1.16
Cross Busy and 4K Association Limit per Console for Conventional
Talkgroups
A console associates a Conventional Talkgroup to receive cross busy information. A Conventional
Talkgroup has cross busy indications showing activity by other talkgroups on the same Conventional
Talkgroup channel, or an RF cross busy Conventional Talkgroup channel. When a cross busy due to a
console with another talkgroup on the same channel occurs, an attempted console transmit results in
busy/queuing by the call controller. When a cross busy is due to a console with another talkgroup RF
cross busy Conventional Talkgroup channel, an attempted console transmit results in the lower priority
console backing off. When a cross busy is due to subscriber or cross busy due to subscriber
emergency, a console transmit results in taking over the outbound audio path from the subscriber.

There is a 4000 association limit per console. The console operator is notified if the associations
exceed the limit. It is not possible to exceed the limit when no RF cross busy Conventional Talkgroup
channels exist. If more than 48 RF cross busy Conventional Talkgroup channel pairs are entered into
Network Manager, conditions start to exist where a console could exceed 4000 associations.

4.2
Call Reception
The console operator position can receive communications from radios by responding to Inbound
Calls, Clear Audio Alerts, and Cross Mode Alerts. Clear Audio Alerts and Cross Mode Alerts are two
additional features available in some ASTRO systems.

Inbound Call
If a call is received on the Resource while the Resource is not selected, the call indicator is solid (not
flashing). If the operator position selects a Resource for an inbound call, the call indicator flashes.

When a call is received on a hidden folder on the Dispatch console desktop, two call indications are
possible. The Inbound Call indication  is first priority, and the Emergency indication  is second
priority when received on the same hidden folder.
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NOTICE: The call indications appear on the folder tab of the hidden folder.

Clear Audio Alert (RX)
If a secure-only console has been configured in Elite Admin to provide Clear Audio indications, the
console generates a clear Audio Alert tone and displays the Clear Audio Receive indicator  on a
Resource receiving clear audio.

Cross-Mode Alert

The Cross-Mode Alert indicator  warns the operator that a call has been received in a different
mode than the current transmit mode.

NOTICE: Transmitting back to the resource without changing the mode may result in the radio
not being able to hear the transmission, and/or the operator may be transmitting clear when the
transmission should be coded/encrypted. The operator must change the transmit mode to
match the inbound transmission when this indicator appears. For more information, see 
Transmit Mode Select on page 79.

Related Links

Selecting the Transmit Mode for Outbound Transmissions

4.2.1
Responding to Calls
Perform this process to respond to calls.

Process:
1 In the Elite Dispatch window, select the Resource that contains the call indicator.

NOTICE: If the channel is selected, the audio from the radio switches from the Resource
unselect audio destination to its select audio destination (speaker or headset).

2 Perform one of the following procedures:

• Send a general transmit as described in Sending General Transmits on page 78.

• Send an instant transmit as described in Sending Instant Transmits on page 79

4.3
Paging Options
Paging options allow the Dispatch Operator to send Call Alerts or pages to a group of resources or to
communicate with field personnel who do not have radios.

The following options are available to the Dispatch Operator:

• Sending a Quick Page

• Sending a Standard Page (Using the Page List)

• Sending a Standard Page (Manually)

• Sending a CheckList Page

• Resending Failed Pages

On the screen, Paging Resources are small windows with an Alias name and a QuickPage button:
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Figure 11: Paging Resource

After initiating a paging session, the following restrictions apply:

• It is not possible to initiate another page.

• It is not possible to send a General Transmit to any Resource included in the paging session.

• It is not possible to add to the page queue list.

• It is not possible to remove a page member from the page queue.

4.3.1
Console Selected Resource Pages
In an ASTRO® 25 system, the Network Management software (NM Client) is used to create pages for
use by consoles enabled for paging.

Certain pages are called Console Selected Resource Pages. This type of page does not contain pre-
configured channel information. Rather, when a Console Selected Resource Page is added to a
standard or check list page, the channel used is the channel that is active at the time the page is added
to the queue.

4.3.2
Sending QuickPages
When a Page Resource is part of a configuration, its member resources receives a page upon
activation of the QuickPage button.Some Page Resources are configured as safety protected. In that
case, a Dispatcher must use the safety switch button in the toolbar before sending a page.

Procedure:
1 On a Page Resource, click the QuickPage button.

NOTICE: Only one QuickPage can be sent at a time.

4.3.3
Sending Standard Pages from the Page List
Perform this procedure to send Standard Pages from the Page List.

Procedure:
1 In the toolbar, click the Standard Page button.

2 Select the Page List tab and perform one of the following actions:

• To display Master Resources, select the Master button.

• To display Custom Resources, select the Custom button.

3 Select the Page Resources to which you wish to send a page and perform one of the following
actions:

• To add Resources to the Pending Pages list, click the Right arrow button.

• To remove Resources from the Pending Pages list, click the Left arrow button.

NOTICE: If you select group page resources, the Pending Pages list shows the
individual page members, not the group page alias name.
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4 To display details for a particular resource or group, click on a resource or group name in either
list and click the Details >> button.

The bottom of the dialog box expands to show paging information of the selected Page
Resource.

NOTICE: If you select a Console Selected Resource Page from the Page List, the
Resource is displayed as Currently Selected.

Figure 12: Resource Displayed as Currently Selected

If you select a Console Selected Resource Page from the Pending Pages list, the
Resource chosen for the Console Selected Resource Page in this activity, is displayed.

Figure 13: Resource Chosen for the Console Selected Resource Page

5 To view paging information for that member, click on a resource in the Group Members list of
the Details panel.

6 Close the Details panel by clicking the Details << button.

7 To send a page to all Resources in the Pending Pages list, click Send.

The Pending Pages list displays the page status next to each resource during the paging
session. If a page was successful, a green checkmark appears next to the resource name. If a
page was unsuccessful or an error occurred, a red X appears next to the resource name.

8 Perform one of the following actions:

• To stop the paging session, click Abort.
• To close the Standard Page dialog box without sending any changes, click Close.

• When finished, to close the Standard Page dialog box, click Close.

Related Links

Resending Failed Pages on page 89

4.3.4
Sending Standard Pages Manually
Perform this procedure to send Standard Pages manually.
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Procedure:
1 From the toolbar, select the Standard Page button.

2 In the Standard Page dialog box, select the Manual tab.

3 In the Manual tab, in the text box, enter a <Pager ID>.

4 Perform the following actions:

a From the Format drop-down list, select the paging format.

b From the Resource drop-down list, select the paging resource.

c From the Frequency drop-down list, select the paging frequency.

NOTICE: The list of available frequencies depends on the selected Resource.

5 Add the Resource to the Pending Pages list by clicking the Right arrow button.

The Resource is displayed in the list as Manual 1.

NOTICE: Additional manual pages are incremented automatically by 1 when added to
the queue. The counter is reset when the paging session ends.

6 Perform the following actions:

a To display the details for a particular Resource, select the Resource from the Pending
Pages list and click Details >>.

The bottom of the dialog box expands to show paging information for the selected Resource.

b To close the Details panel, click Details <<.

c To send the page to all Resources in the Pending Pages list, click Send.

The Pending Pages list displays the page status next to each resource during the paging
session. If a page was successful, a green checkmark appears next to the resource name. If
a page was unsuccessful or an error occurred, a red X appears next to the resource name.

7 Perform one of the following actions:

• To stop the paging session, click Abort.
• To close the Standard Page dialog box without sending any changes, click Close.

• When finished, to close the Standard Page dialog box, click Close.

Related Links

Resending Failed Pages on page 89

4.3.5
Sending CheckList Pages
CheckList Page sends pages to a collection of page resources. It allows the operator to create a group
page on the fly using the paging resources on the screen.

Procedure:
1 From the toolbar, select the CheckList Page button.

2 Select the desired Page Resource.

The page resource displays in the added state (white background) or shows that the resource
cannot be added.
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3 Repeat step 2 for each Page Resource.

4 When all desired resources have been selected, click the Send Page button in the toolbar

At this point, no more page resources can be added and the CheckList Page button is disabled.

The page is sent to the selected Resources. For Talkgroups or Multigroups, the page is sent to
each member of the group.

NOTICE: If any error occurred in step 2, the system automatically enters Resend Page
mode.

5 Optional: To stop the paging session, click Abort.

4.3.6
Resending Failed Pages
When a paging session ends, Elite Dispatch gives the Dispatch Operator the option to resend any
pages that failed to be sent. In resend mode, the Send button changes to Resend.

In the Pending Pages list, the pages from the previous paging session are marked with the following
status indicators:

• The clear icon  marks sent pages.

• The error icon  marks failed pages.

Procedure:
1 To resend the failed pages, on the right side of the Standard Page window, click Resend.

The pages sent successfully from the previous session are cleared from the queue and any
failed pages are attempted again. When the new paging session ends, the pages from this
session are marked with appropriate status indicators.

NOTICE: If you do not click Resend in 20 seconds after the last paging session, Elite
Dispatch clears all the pages from the queue.
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Chapter 5

Phone Communication
The Motorola MCC 7500 VPM and MCC 7500E Dispatch Consoles support the following types of
phone communication: call placing, call reception, transferring, and forwarding phone calls in both full
or half duplex mode.

5.1
Initiating Phone Calls
Perform this procedure to initiate phone calls.

Procedure:
1 In the Elite Dispatch window, select the Phone Resource to transmit on.

The selected resource appears with a white background and a blue border.

2 Perform one of the following actions:

• If the Dialer window displays automatically after selecting the Phone Resource, go to step 4.

• If the Dialer window does not display automatically after selecting the Phone Resource,
perform step 3.

3 From the Phone menu, select Dialer.
4 In the Dialer window, enter the phone number you wish to call.

5 Initiate the call by clicking the Phone Off Hook button.

Related Links

Initiating Phone Calls from Phone Books on page 92

5.2
Redialing Phone Numbers
Perform this procedure to redial phone numbers.

Procedure:
1 In the Elite Dispatch window, select the Phone Resource to transmit on.

The selected resource appears with a white background and a blue border.

2 Perform one of the following actions:

• If the Dialer window displays automatically after selecting the Phone Resource, go to step 4.

• If the Dialer window does not display automatically after selecting the Phone Resource,
perform step 3.

3 From the Phone menu, select Dialer.
4 Initiate the call by clicking the Phone Redial button.
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5.3
Phone Books
Instead of dialing phone numbers manually, the Dispatch Operator can select entries from the shared
phone book and the local phone book.

This list describes phone book types available to the Dispatch Operator:

Shared Phone Book
A shared phone book is a .CSV file placed in a common localization specified by your organization
and maintained by a System Administrator. The consoles synchronize with the file at regular
intervals and Dispatch Operators always have access to an up-to-date version of the book.

Local Phone Book
A local phone book is part of an .ELT configuration file created by a Console Administrator. It can
contain entries added manually by the Administrator and entries selected from the shared phone
book. The Dispatch Operator can use the local phone book entries to create speed dials.

Related Links

Initiating Phone Calls from Phone Books on page 92
Adding Speed Dials to Folders on page 71

5.3.1
Initiating Phone Calls from Phone Books
Perform this procedure to initiate phone calls from phone books.

Procedure:
1 In the Elite Dispatch window, select the Phone Resource to transmit on.

The selected resource appears with a white background and a blue border.

2 Perform one of the following actions:

• If the Dialer window displays automatically after selecting the Phone Resource, go to step 4.

• If the Dialer window does not display automatically after selecting the Phone Resource,
perform step 3.

3 From the Phone menu, select Dialer.
4 Select the phone book to use:

• For the shared phone book, select the Master tab.

• For the local phone book, select the Custom tab.

5 From the list in either tab, select an entry that you wish to call.

6 Initiate the call by clicking the Phone Off Hook button.

Related Links

Initiating Phone Calls on page 91

5.4
Dual-Tone Multi-Frequency Overdial
Dual-Tone Multi-Frequency (DTMF) is transmitting tones over telephone lines to communicate with
other devices and the switching center. The Dispatch Operator transmits the tones by dialing digits on
the keypad.
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The DTMF overdial is available on MCC 7500 VPM and MCC 7500E Dispatch Consoles with the
Console Telephony feature installed.

The Dispatch Operator can dial the required digits by using:

• The Dialer keypad. After you establish the call, select the required digits on the Dialer keypad.

• An entry from the local or shared book if you have the required sequence of digits saved in one of
them. After you establish the call, dial the required entry from the phone book.

• A speed dial if you have one for the required sequence of digits in one of your folders. After you
establish the call, click the speed dial to transmit the required tones.

NOTICE: When first establishing a call from the MCC 7500E Dispatch Console, you can also
choose a whole dialing sequence: the phone number, the pauses and the additional digits for
overdial.

Related Links

Adding Speed Dials to Folders on page 71
Initiating Phone Calls on page 91

5.5
Phone Call Reception
Apart from initiating Phone Calls from the Dispatch Operator position, the Dispatch Operator can
receive inbound connections from other Phone Resources.

Inbound Phone Calls
When a Dispatch position receives an inbound call, it is displayed on one of the available Phone
Resources. As the Phone Resources are numbered from Phone 01 to Phone 20, the inbound call is
always allocated to the lowest numbered available phone resource. The phone resource displays
ringing indications and the console sounds the configured ringing tone. After the Dispatch Operator
answers the call by selecting the ringing telephone resource, the phone call is established.

Phone Call Received in a Hidden Folder
When a phone call is received in a hidden folder on the Dispatch Console desktop, two different call
indications are possible. The Inbound Phone Call indication is first priority, and the Emergency
indication is second priority when received in the same hidden folder.

NOTICE: The phone call indications appear on the folder tab of the hidden folder.

Figure 14: Inbound Phone Call Indication in a Hidden Folder
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Headset Priority Rules
The Elite Dispatch Console supports three sets of priority rules for using the headset.

• When a Dispatch Operator uses a headset, the External Phone Interface (EPI) audio takes
precedence.

• When a call through the External Phone Interface (EPI) is in progress, the audio from the EPI is
routed to the headset as it has priority over the console telephony audio.

• The console telephony audio has priority over audio from selected radio resources.

5.5.1
Answering Inbound Phone Calls
Perform this procedure to answer inbound phone calls.

Procedure:
In the Elite Dispatch window, select the Resource that contains the call indicator.

The call is transmitted on a selected Resource and the call audio switches from the phone line
Unchosen Speaker to the phone line Chosen Speaker.

5.6
Transferring Phone Calls
The Dispatch Operator can transfer a call directed to their Console Position to another Dispatch
Operator or telephone number:

NOTICE: The call transfer feature is not supported for calls established from one MCC 7500
dispatch position to another MCC 7500 dispatch position.

Procedure:
1 In the Elite Dispatch window, select the Phone Resource on which there is a call.

The selected resource appears with a white background and a green border.

2 In the Resource window, click the Phone Transfer (for MCC 7500 VPM Dispatch Console)/
Attended Call Transfer (for MCC 7500E Dispatch Console) button.

3 In the Phone Transfer/ Attended Phone Transfer window, specify the phone number to which
the call is to be transferred by performing one of the following actions:

• To use a shared phone book entry, select the Master button.

• To use a local phone book entry, select the Custom button.

• To dial the number, click the Dialer button.

4 Perform one of the following actions depending on the type of your Dispatch Console:

If... Then...

If you are using the MCC 7500 VPM Dis-
patch Console,

after you select or dial a number, click the
Transfer button.

If you are using the MCC 7500E Dispatch
Console,

perform the following actions:

a after you select or dial a number, click
the Announce button.
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If... Then...

b talk to the party receiving the transferred
call, and verify they are the right target
for the call.

c if they are the right target for the call be-
ing transferred, click Complete.

d if they are not the right target for the call
being transferred, click Phone on Hook
to disconnect the call, and return to step
3.

If the call is transferred successfully, a success indication momentarily appears on the Phone
Resource.

5 To close the Phone Transfer/ Attended Phone Transfer window, click Close.

5.7
Forwarding Phone Calls
The Dispatch Operator can forward their incoming calls to other Dispatch Operators.

Procedure:
1 From the Phone menu, select the Forward option.

2 In the Forwarding window, specify the forwarding phone number:

• To dial the phone number manually, select the Number Dial tab. Enter the phone number
you wish to dial.

• To dial a shared phone book entry, select the Master tab. Select the entry you wish to dial.

• To dial a local phone book entry, select the Custom tab. Select the entry you wish to dial.

3 Set the forwarding phone number by clicking the Phone Call Forward button.

If forwarding is set successfully, all the configured gateways acknowledge the operation. If not

all the gateways acknowledge the operation, the Partial Forwarding indicator  is
displayed.

4 Optional: If you see the partial forwarding indication, perform one of the following actions:

• Retry to set forwarding by repeating step 3.

• If retrying to set forwarding fails, notify the support team.

Postrequisites: For the MCC 7500E Dispatch Console review the following actions.

NOTICE: When forwarding calls for the MCC 7500E Dispatch Console, a hunt group takes
precedence over call forwarding. For example, assume a configuration where a hunt group with
ID 200 is configured to contain consoles 1111 and 2222, but not console 3333. Additionally
console 1111 had turned on call forwarding to console 3333. In this situation:

• when a call comes in directed at hunt group 200, only console 2222 will ring

• when a call comes in directed at console 1111 via direct inbound dial or a console to console
call, console 3333 will ring.
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NOTICE: For the MCC 7500E Dispatch Console:

• when call forwarding is activated for a phone number from the console, it deletes any
forwarding previously set via the NEC Console Telephony Gateway, and any star codes
dialed directly from the console. Do Not Disturb is activated for that phone number which
overrides the star code entered by the dispatcher to deactivate Do Not Disturb for that phone
number if it has been entered previously.

• when call forwarding is deactivated for a phone number from the console, it deletes any
forwarding previously set via the NEC Console Telephony Gateway, and any star codes
dialed directly from the console. Do Not Disturb is deactivated for that phone number which
overrides the star code entered by the dispatcher to activate Do Not Disturb for that phone
number if it has been entered previously.

5.8
Full Duplex and Half Duplex in Telephone Operations
Depending on the configuration of the Dispatch Position and the action that the Dispatch Operator
performs, telephone operations are performed in full duplex or half duplex mode.

If a headset is available at the dispatch position, phone calls operate in hands-free full duplex mode.
The hands-free full duplex mode requires no Push-toTalk (PTT) operations from the Dispatch Operator
to talk on the phone. Inbound audio from phone calls is routed to the headset, and the console transmit
audio is sent from the headset microphone to the telephone caller.

If no headset is available at the Dispatch Position, phone calls operate in half duplex mode. Half duplex
operation is similar to communications on radio resources. Each time the Dispatch Operator wants to
speak on the phone, they must perform a PTT operation on the Phone Resource to which the call is
assigned.

In certain situations, priority for the headset is given to other dispatch use cases, such as console
transmit operations or External Phone Interface (EPI). If the headset is re-allocated to another use
case when a phone call is in progress, the phone call temporarily changes to half duplex mode and
reverts to hands-free full duplex mode after the higher priority dispatcher operation ends.
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Chapter 6

Elite Dispatch Features
This chapter introduces additional features available in Elite Dispatch. The advanced options explained
here include handling Emergency Alarms and Calls, managing radio units and Secure Keys, and more.

6.1
Emergency Alarm and Call
This feature is applicable for the MCC 7100 and MCC 7500 VPM Dispatch Consoles. Two emergency
classes are included in this feature: Emergency Alarm and Emergency Call.

Emergency Alarm
Alerts console positions of an emergency situation by sending a distinct tone to the console
speaker or headset.

Emergency Call
Initiated while a radio is in emergency mode and provides higher priority communication than a
regular radio call. Emergency Calls do not generate a tone.

When an Emergency Alarm or Call is received for a resource, the following events occur:

• The volume of the resource is automatically set to maximum.

• The resource border flashes red.

• Depending on the type of emergency, the status line in the resource header displays Emerg Alarm
or Emerg Call.

• Depending on the type of emergency, the Stack displays Emerg Alarm or Emerg Call in red.

• Depending on the type of emergency, the Activity Log displays Emerg Alarm or Emerg Call in
red.

• For each Emergency Alarm received at an operator position, a continuous emergency tone is
generated.

Figure 15: Emergency Alarm and Call Indicators

Related Links

Stack Functionality on page 115

6.2
Emergency Alarm, Call and Man Down Feature
This feature is applicable for the MCC 7500 E Dispatch Console. Three emergency classes are
included in this feature: Emergency Alarm, Emergency Call and Man Down.
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Emergency Alarm
Alerts console positions of an emergency situation by sending a distinct tone to the console
speaker or headset.

Emergency Call
Initiated while a radio is in emergency mode and provides higher priority communication than a
regular radio call. Emergency Calls do not generate a tone.

Man Down
Alerts console positions of a Man Down situation, by sending a distinct tone to the console speaker
or headset.

When an Emergency Alarm, Call or Man Down is received for a resource, the following events occur:

• The volume of the resource is automatically set to maximum.

• The resource border flashes red.

• Depending on the type of emergency, the status line in the resource header displays Emerg Alarm
or Emerg Call or Man Down.

• Depending on the type of emergency, the Stack displays Emerg Alarm or Emerg Call or Man
Down in red.

• Depending on the type of emergency, the Activity Log displays Emerg Alarm or Emerg Call or
Man Down in red.

• For each Emergency Alarm received at an operator position, a continuous emergency tone is
generated.

• For each Man Down situation received at an operator position, an continuous emergency Man
Down tone is generated.

Figure 16: Emergency Alarm and Call Indicators

6.3
Emergency Calls Treated as Normal Calls
The Emergency Call as Normal Call feature allows the Dispatch Administrator to configure specific
channels in the .elt configuration to suppress emergency indications to the Dispatch Operator.
Audible and/or visual emergency indications can be suppressed independently.

The administrator enables the feature for a specific channel by turning off the visual and audible or only
audible indications of an incoming emergency call on this channel. By using various .elt files for
various consoles, it is possible to specialize the dispatch operators in dealing with specific types of
calls, for example, calls from a specific region.

When the Emergency Calls Treated as Normal Calls feature is enabled in a specific .elt configuration
for a specific radio resource, the dispatch operator who uses this configuration sees the emergency
calls on this resource as normal calls. At the same time, a dispatch operator who uses a different
configuration sees it as an emergency call.

Regardless of the settings on specific consoles, all emergency calls coming to a dispatch center are
always logged as emergency calls in the audio logging system.
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6.4
Answering Emergency Transmissions
The Dispatch Operator is responsible for acknowledging emergency transmissions and responding to
them.

Procedure:
1

On a resource, click the Emergency button .

NOTICE: Opening the flap on a compressed resource with an unacknowledged
emergency automatically opens the Emergency QuickList.

Figure 17: Emergency QuickList

2 Optional: To turn off the emergency tones for all the emergencies currently active at the console,

click the End Emergency Tones button  on the toolbar.

Turning off the emergency tones does not end the emergency state of any of the events that
triggered the emergency tones.

3 In the Emergency QuickList, select the entry to be acknowledged. Click the Acknowledge

Emergency button .

The emergency tone ends and the resource window border stops flashing (as long as no other
unacknowledged emergency entries remain). A green check mark is placed next to the Unit ID
entry in the QuickList, next to the corresponding entry in the Stack, and in the Activity Log. The
check mark indicates that an operator is handling the emergency. These results appear at all
operator positions monitoring the resource.

4 Talk to the radio that sent an Emergency Call by clicking and holding the Transmit button.

6.5
Ending Emergencies

After all emergency entries for a resource get acknowledged, the Knockdown button  becomes
active.
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Procedure:
Terminate the emergency state on the resource by clicking the Knockdown button.

The following events occur:

• The resource volume is back to normal.

• The emergency is cleared at all operator positions monitoring the resource.

• All entries are removed from the Emergency QuickList.

• The resource border is changed to the original color from before the emergency.

• The status line of the resource header goes blank and the corresponding entry in the stack changes
from red to black.

• The Activity Log entry color remains unchanged.

6.6
Initiating Emergency Calls
The Dispatch Operator can initiate Emergency Calls from the console. This option is available in
trunking systems only.

Procedure:

1 In the Resource window, click the Emergency button .

2 In the Emergency QuickList dialog box, initiate a console emergency by clicking the Setup
button.

3 Click and hold the Transmit button to talk.

An operator receiving a console emergency sees their resource border turn red and the call is
acknowledged automatically. The operator then has the opportunity to handle the emergency and
knock it down.
If the operator initiating an emergency switches dispatch configurations or exits the current
configuration while an emergency is unacknowledged, the emergency is knocked down from the
initiating operator console and from all other operator positions monitoring the channel on which the
emergency was engaged.

Regardless of which operator position sets up an emergency, any operator position can knock it down.

6.7
Outbound Signaling with the QuickList
The QuickList is used to select a radio to communicate with and contains two lists of resource aliases:
the Master List and the Custom List, as indicated by buttons on the window. The operator may also
enter a unit ID by selecting the 1-9/A-Z button in the QuickList window.
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Figure 18: Selecting Radios in the Quick List by Unit Aliases

Figure 19: Selecting Radios in the Quick List by Unit ID

NOTICE: For channels capable of MDC1200 signaling, the Elite Dispatch application displays a
keypad that allows for hexadecimal unit ID entry.
For channels not configured for MDC1200 operation, Elite Dispatch displays a numeric keypad
with disabled hexadecimal keys (A, B, C, D, E, and F).

For channels configured for MDC1200 operation and Non-Standard display mode, Elite
Dispatch displays a numeric keypad with enabled hexadecimal keys (A, B, C, D, E, and F).

For channels configured for MDC1200 operation and Standard display mode, Elite Dispatch
displays a numeric keypad with enabled hexadecimal keys (A, B, C, D, and in some cases E).
For the first character in the unit ID of an MDC channel configured with hexadecimal and
Standard display mode, Elite Dispatch displays a numeric keypad with disabled E key.

Non-Standard MDC1200 operation allows the unit ID range to expand from 0x0000-0xFFFF.

Standard MDC1200 operation reserves the range 0xE000-0xEFFF for group operations. Thus,
the allowed unit ID range is 0x0000-0xDEEE.

Procedure:
1

If… Then…

If you want to
select radios
in the Quick
List by Unit
Aliases,

perform the following actions:

a Select the list from which you want to choose a radio by clicking on
Master or Custom.

b From the list, select an alias of the radio.
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If… Then…

NOTICE: The Unit ID corresponding to the selected alias is
shown adjacent to the alias at the top of the QuickList. If
part of an alias name is not visible, a tooltip displays the full
name.

c Transmit the corresponding feature associated with the QuickList by
clicking the Send button.

If you want to
select radios
in the Quick
List by Unit ID,

perform the following actions:

a Click the 1-9/A-Z toggle button.

b Specify the Unit ID of the desired radio by clicking the numbered but-
tons.

c Delete any incorrect characters by clicking the backspace arrow.

d Transmit the corresponding feature associated with the QuickList by
clicking the Send button.

6.8
Main/Alternate Channel Control
The Main/Alternate Channel Control feature allows a Dispatch Operator to choose which channel is
active for a conventional site.

If this capability is enabled, the following icons are visible in the Dispatch application:

Main Channel active indicator

Alternate Channel active indicator

Main/Alternate state Unknown indicator

A Dispatch Operator can choose the active channel by toggling the Main/Alternate icon between the
main and alternate channel.

IMPORTANT: Contact your system administrator for instructions on how to enable a re-
configured Main/Alternate channel pair.

IMPORTANT: If the state of the Main/Alternate feature changes multiple times within a short
period of time, it can affect the Repeat Control feature. Verify that the Repeat Control icon
reflects the desired state of the repeater after all Main/Alternate feature changes are complete.

6.9
Sending Call Alerts
If the console position or radio receives a call request from a specific radio unit, the words Call
Alert are displayed in the status line of the Resource window, and a momentary tone consisting of
four long beeps is heard.
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Procedure:

1 In the Resource window, click the Call Alert button .

2 In the QuickList, select an Alias/Unit ID. Click Send.

3 Optional: To abort a Call Alert in progress, click the Call Alert button.

While the system is trying to establish a connection with the radio unit, a green circle flashes in the top
left corner of the button and the text Call Alert appears in the status line of the Resource window.
After the connection is established and the call alert data is successfully sent, the green circle
disappears. If the call fails, the status line is updated with the failed call information.

Related Links

Outbound Signaling with the QuickList on page 100

6.10
Sending Status Requests
Status Requests allow the Dispatch Operator to remotely interrogate a radio unit and obtain its status.

Procedure:

1 On a Resource, click the Status Request button .

2 In the QuickList, select an Alias/Unit ID. Click Send.

3 Optional: To abort a Status Request in progress, click the Status Request button.

While the system is trying to establish a connection with the radio, a green circle flashes in the top left
corner of the button. When the connection is established and the targeted radio unit has responded to
the request, the green circle disappears and the radio unit status is displayed in the Resource header.
If the call fails, the status line is updated with the failed call information.

Related Links

Outbound Signaling with the QuickList on page 100

6.11
Sending Radio Checks
Radio Checks allow the Dispatch Operator to check if the radio unit is functioning on a Resource
without causing interruption to the specific radio unit. It can be used as a routine preventive
maintenance check or when the Dispatch Operator has some reason to doubt the availability of the
radio unit.

Procedure:

1 On a Resource, click the Radio Check button .

2 In the QuickList, select an Alias/Unit ID. Click Send.

3 Optional: To abort a Status Request in progress, click the Radio Check button.

While the system is trying to establish a connection with the radio unit, a green circle flashes in the top
left corner of the button. After the connection is established and the targeted radio unit responds to the
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request, the green circle disappears and the status message Acknowledged appears in the Resource
header. If the call fails, the status line is updated with the failed call information.

Related Links

Outbound Signaling with the QuickList on page 100

6.12
Sending Remote Monitor Requests
A Remote Monitor request allows the Dispatch Operator to remotely command a radio to key-up its
microphone and transmit for a short period of time. The feature is used if a radio is stolen or if the user
is not responding to calls. It is a listen-only mode and the radio shows no indication that it is
transmitting.

Procedure:

1 On a Resource, click the Remote Monitor button .

2 In the QuickList, select an Alias/Unit ID. Click Send.

While the system is trying to establish a connection with the radio unit, a green circle flashes in the top
left corner of the button. After the connection is established and the targeted radio unit responds to the
request, the green circle disappears and the status message Monitored appears in the Resource
header. The operator can hear what is happening at the radio as if the radio user had pressed the
Push-to-Talk (PTT) button on the radio.
If the call fails, the status line is updated with the failed call information. A Remote Monitor request in
progress cannot be aborted and times out after a period of twice the time-out setting programmed into
the radio unit.

Related Links

Outbound Signaling with the QuickList on page 100

6.13
Disabling and Enabling Radios
The Dispatch Operator can enable or disable a radio unit remotely. This feature can be used to disable
any stolen or lost radio unit as well as enable any previously disabled radio unit.

Procedure:

1 On a Resource, click the Radio Enable/Disable button .

2 In the QuickList, select an Alias/Unit ID. Perform one of the following actions:

• If you want to disable a radio, click the Radio Disable button.

• If you want to enable a radio, click the Radio Enable button.

3 Optional: To abort disabling or enabling a radio in progress, click the Radio Enable/Disable
button on the Resource.

While the system is trying to establish a connection with the radio unit, a green circle flashes in the top
left corner of the button. After the connection is established and the targeted radio unit responds to the
request, the green circle disappears and the status message Enabled or Disabled appears in the
Resource header. If the command fails, the status line is updated with the failed command information.
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Related Links

Outbound Signaling with the QuickList on page 100

6.14
Initiating Voice Selective Calls
The Voice Selective Call feature allows a console or radio user to communicate with a single console
or radio without having other units on the same channel listen to the conversation. It eliminates the
annoyance of users having to listen to traffic that has nothing to do with them. The Dispatch Operator
can both receive and send a Voice Selective Call. When a console receives a radio-initiated Voice
Selective Call, the status message Voice Sel Call appears on the Resource header, a series of
tones are heard, and the audio from the transmitting radio is immediately heard at the console operator
position.

Procedure:

1 On a Resource, click the Voice Sel Call button .

2 In the QuickList, select an Alias/Unit ID. Click Send.

3 Optional: To abort a voice selective call in progress, click the Voice Sel Call button.

4 To complete the call, press and hold the Transmit button.

Otherwise, the call may time out.

5 To end the call, release the Transmit button.

If there is no audio activity for a period of time, the call ends.

While the system is trying to establish a connection with the radio unit, a green circle flashes in the top
left corner of the button. If the set-up time is short, the circle may not flash. After the connection is
established and voice activity begins, the green circle is solid and the status message Voice Sel
Call appears in the Resource header. These indicators disappear after the call ends. If the call fails,
the status line is updated with the failed call information.

Related Links

Outbound Signaling with the QuickList on page 100

6.15
Activating Channel Markers
If the Channel Marker feature is configured for a resource, the Dispatch Operator can use Channel
Markers to identify a channel as priority and warn non-critical radio users not to transmit. A single
operator position is permitted to activate up to 5 channel markers.

Procedure:

On a Resource, click the Channel Marker button .

All parallel Dispatch consoles see an activated channel marker and any operator position can
deactivate it.
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6.16
Sending Momentary Overrides
The Momentary Override feature provides a quick way for the operator to perform a secure
transmission on selected resources using a specified secure key without permanently changing the
Transmit settings of the resources. When Auto-key is chosen as the Momentary Override Key, coded
transmissions from a console use the last Secure Key received from a coded transmission on that
resource. The system administrator specifies Auto-key. Typically, the auto key is the last Secure Key in
the Momentary Override Key drop down list.

NOTICE: Auto-key is not available on analog conventional resources.

Procedure:
1 In the Elite Dispatch Console window, select the relevant resource.

2 From the Momentary Override drop-down list , select a secure key used for secure
transmissions.

3 Send a secure transmission on all currently selected resources by clicking and holding the
Momentary Override button.

Transmission activity is indicated by a red lightning bolt on the button.

4 Optional: To end a Momentary Override, release the Momentary Override button.

The lightning bolt on the button changes color from red to gray.

If a resource does not have the Momentary Override key available or the resource does not have
secure transmission capability, it cannot transmit. Other resources which have a key select limit of 8
keys can only transmit via Momentary Override with select values of 1–8.

Example: Advanced SECURENET (ASN) Conventional channels are limited to 8 keys. If a
Dispatch Operator needs Momentary Override to key up both ASN channels and other types of
secure channels grouped into the same multi-select group, the CKR list must include keys
indexed in the range of 1–8 that are also valid CKRs for use on the non-ASN channels in the
MSEL group. It is up to the system administrator to map CKRs and ASN key numbers so that
interoperability of secure communications between ASN channels and other secure channels
is possible. For more information about key mapping, see “Mapping Keys” in the Secure
Communications Feature Guide.

6.17
Selecting Secure Keysets
The user can change the active secure keysets for resources.

Procedure:
1 From the menu, select Features → Secure Operations.

The Secure Operations window opens showing the currently active keyset.

2 In the Secure Operations window, change to a different keyset by selecting the desired keyset
from the drop-down list.

NOTICE: If the console is not configured to allow the keyset to be changed, the Secure
Operations window shows the currently active keyset but the field is grayed out and the
drop-down list is disabled. If the mouse is hovered over the alias, a tooltip shows both the
keyset alias and the keyset ID. If the keyset has no alias, only the keyset ID is displayed.
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3 To apply the changes, click Close.

6.18
Selecting Secure Keys for Analog Channels
The Outbound Secure Key feature allows the user to select from a list of different encryption keys for
the purpose of secure transmissions. The resource must be set to a coded transmit mode for the
selected secure key to work.

Procedure:

1 On a Resource, from the Secure Key drop-down list , select the desired secure
key.

2 Set the resource to the Coded Transmit mode by clicking on the Transmit Mode button  on
a Resource.

3 Begin the secure key transmission by clicking and holding the Transmit button.

4 End the secure key transmission by releasing the Transmit button.

ASTRO® 25 resources can have up to 255 non-consecutive keys in the range of 1–255. Other
resources with Secure Key can have up to 8 consecutive keys in the range 1–8.

6.19
Deleting Secure Keys for MCC 7100 and MCC 7500E Dispatch
Consoles
A hardware-based zeroize button is not available on the software-based consoles so the Dispatch
Operator deletes secure keys by sending a software command.

Procedure:
1 From the Features menu, select Secure Operations.

2 In the Secure Operations window, click the Delete Secure Keys button .

3 Click Close.

6.20
Transmitting on Consolettes
In some conventional ASTRO systems, operators of MCC 7500 VPM and MCC 7500E Dispatch
Consoles can communicate with subscriber radios through a consolette (for example, the ASTRO
Digital XTL 5000 or the Digital Multi-band APX 7500). These consolettes are often called control
stations since they are programmed with channels that can transmit, even if the Dispatch site has lost
communication with the central ASTRO network. Communication on a consolette is similar to any other
transmission.
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NOTICE: To access a consolette from the dispatch position, use an ACIM resource channel.
ACIM channels can be MDC signaling capable or non-MDC signaling capable.
If an MDC signaling capable ACIM channel is configured with a digital channel, for radios that
use this digital channel and have no aliases defined, the ACIM resource channel displays radio
IDs in the hexadecimal mode.

If a non-MDC signaling capable ACIM channel is configured with an MDC channel, for radios
that use this MDC channel and have no aliases defined, the ACIM resource channel displays
radio IDs in the decimal mode.

Procedure:
1 From the Dispatch desktop, select the consolette resource.

2 If the resource is in the compressed view, expand the resource by using the down arrow button.

3 From the Frequency Select drop-down list, select the frequency for the call by clicking the

Frequency Select button .

The corresponding channel is keyed up at the consolette.

4 On a Resource, select the mode of transmission by clicking the Transmit Mode button .

The transmit mode selected at the console does not always result in the same over-the-air mode
of transmission by the consolette. The actual transmit mode depends on the frequency selected
in step 2.

5 If the Secure Key Out capability is enabled, from the Secure Key drop-down list, select a
Secure Key to be used for encrypted communication by clicking the Outbound Secure Key

button .

Encryption is provided by the consolette and not by the dispatch console.

6 Perform a general transmit or instant transmit. For more information, see Sending General
Transmits on page 78 or Sending Instant Transmits on page 79

NOTICE: If another feature is selected that is not supported by the consolette (for
example, a call request on a receive-only channel), the transmission fails.

6.20.1
Consolette Inbound Calls
Consolettes can receive calls from subscribers.

When a consolette receives a call from a subscriber:

• The inbound call indicator appears on the consolette resource on the Dispatch desktop.

• If Secure Key In capability is enabled, the resource shows the key it receives (the consolette
decrypts the inbound audio).

6.21
Group Text Messaging
The Group Text Messaging feature allows the Dispatch Console Operator to send text messages to
radio subscribers using trunking talkgroup resources.

To configure Group Text Messaging, use the Elite Admin application. Configuration options include:

• Logging sent messages to a file
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• Creating predefined messages for the Dispatch Operator

• Configuring the information visible on the Outbound Messages list

• Adding the Group Text Messaging button to the Toolbar and/or Radio Resources

• Adding the Group Text Messaging Window option to the View menu

See the Elite Admin User Guide for more information.

To send Group Text Messages, use the Elite Dispatch application. See: Sending Group Text
Messages on page 109.

Group Text Messages sent from other Operator Positions are visible in the Elite Dispatch application in
the Activity Log window and on the Resource on:

• Resource Header

• Three Line Display

• Stack

A tooltip is provided for messages that are too long to fit the specific display.

The configuration whether Incoming Group Text Messages are visible in the Activity Log window and
on the resource (on the Three Line Display, the Stack, the Resource header) is done in the Elite Admin
application. It is similar to configuring the display of other features available for the Resource. See the
Elite Admin User Guide for resource configuration instructions.

6.21.1
Sending Group Text Messages
Use the following procedure to send a Group Text Message.

For more information regarding Outbound Messages, see: Outbound Messages List on page 111.

For instructions on sending Group Text Messages using the Stack, see: Sending Group Text
Messages Using the Stack on page 111.

Procedure:
1 Open the Group Text Messaging Window. Perform one of the following actions:

• From the menu, select View → Group Text Messaging Window.

• On the Toolbar, click the Group Text Messaging button.

• On the Resource, click the Group Text Messaging button.

2 In the Group Text Messaging window, from the Resource drop-down list, select the resource
to which you want to send the message.

NOTICE:
If no resources are added to the current folder, the Resource drop-down list is grayed

out, and the information icon  appears next to it. After you add resources to your
folder, they are automatically shown in the Resource drop-down list.

If you opened the Group Text Messaging window using:

• the Toolbar button, the Resource selected on your folder is automatically chosen in
the Resource drop-down list.

• a feature button on a resource, this Resource is automatically chosen in the
Resource drop-down list.

3 In the Text Message text box, type your message.
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The limit is 160 characters. A used/remaining characters counter is provided beneath the Text
Message text box.

To display an on-screen keyboard, click .

To clear the typed in text, click .

4 Optional: To use Predefined Text Messages defined by your Administrator, select a message
from the Predefined Messages drop-down list.

The message text is copied into the Text Message text box. You can edit the predefined
message.

5 In the Radio Display drop-down list, choose one of the following options:

• If you do not want a preview of the message displayed on the receiving radio, select No
Popup Display.

• If you want a preview of the message displayed on the receiving radio, select Popup
Display.

• If you want a preview of the message displayed and a tone played on the receiving radio,
select Popup Display with Tone.

When you choose this option, a warning message appears: Choosing Popup Display
with Tone may be disruptive to the radio users as it causes a
continuous tone to be played until the user acknowledges. Are you sure
you want to choose this?

6 To choose the Popup Display with Tone option, click Yes. To choose a different option, click
No.

7 In the Alert Level drop-down list, select one of the following options:

• None (0)

• Green (1)

• Orange (2)

• Red (3)

where None (0) is the lowest priority message, and Red (3) is a critical message.

8 Optional: To send a message similar to one already sent, highlight a sent message on the
Outbound Messages list to populate all settings with information from the sent message.

After a sent message is highlighted:

• The recipient of the message is chosen in the Resource drop-down list.

• The Alert Level and Radio Display drop-down lists are populated with the settings from the
selected message.

• The message text from the selected message is copied into the Text Message text box.

Edit any settings that you need to change.

9 To send the message, click .

The message is sent and it appears in the Outbound Messages list.

10 To exit the Group Text Messaging window, click Close.
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6.21.2
Sending Group Text Messages Using the Stack
When another Operator Position sends a Group Text Message to a resource, it is shown on the Stack
(depending on the configuration of the resource). The information available is the message text, the
Alert Level of the message, and the Radio Display setting of the message. You can use the Stack entry
to send a similar Group Text Message.

For more information on viewing the stack, see: Viewing Stack Information on page 115.

Procedure:
1 On the Stack, find the entry showing the received Group Text Message. Right-click the entry.

2 From the available options, select Send Text Message.

The Group Text Messaging window opens, and the following fields are automatically filled:

• The Resource which is the owner of the stack is chosen in the Resource drop-down list.

• The Alert Level and Radio Display drop-down lists are populated with the settings from the
stack entry.

• The message text from the stack entry is copied into the Text Message text box.

3 Edit the message as needed.

You can change any setting. For more information about the available options, see Sending
Group Text Messages on page 109.

4 To send the message, click .

The message is sent and it appears in the Outbound Messages list.

6.21.3
Outbound Messages List
Group Text Messages sent by the Dispatch Operator are visible in the Group Text Messaging
window, on the Outbound Messages list. The list is available until cleared by the Dispatch Operator.
When you close the Group Text Messaging window, after sending all messages, and then reopen it,
all sent messages are still visible in the Outbound Messages list. To remove them from the list, see 
Editing the Outbound Messages List on page 112.

The columns available in the Outbound Messages list are configured in the Elite Admin application.
The following is a list of all available columns:

State
The current state of the sent message. One of the following:

•  Pending – The message is queued for delivery or is awaiting a response from the system.
While it is queued for delivery, the message can still be cancelled. See: Editing the Outbound
Messages List on page 112.

•  Begun – The message has been sent to the ASTRO system and is currently being
transmitted to radio subscribers.

•  Ended – Based on elapsed time, it is very likely that the message has been transmitted to
radio subscribers.
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NOTICE: In some cases, for example due to a busy system, the message transmission
may still be in progress, even if the Ended state appeared.

•  Failed – The message has failed to be sent.

NOTICE: In some cases the Failed status can replace the Ended status. This happens
when a message achieved the Ended status (as enough time had passed for the status
to appear), but in fact the transmission was not completed, for example due to a busy
system. Then after the message transmission fails, the Failed status appears.

Resource
The recipient of the sent message.

Message
The text of the sent message.

Timestamp
Date and time when the message was sent.

Radio Display
The Radio Display option set for the sent message. One of the following:

• No Popup Display

• Popup Display

• Popup Display with Tone

Alert Level
The Alert Level option set for the sent message. One of the following:

• None (0)

• Green (1)

• Orange (2)

• Red (3)

6.21.3.1
Editing the Outbound Messages List
Perform this procedure to cancel and/or delete sent messages from the Outbound Messages list.

The Outbound Messages list in the Group Text Messaging window shows messages sent by the
Dispatch Operator. The columns visible in the list are configured in the Elite Admin application.

Prerequisites: The Group Text Messaging feature is enabled for your Console.

Procedure:
1 From the menu, select View → Group Text Messaging Window.

2 To sort the Outbound Messages list, click on the column name of the column you want to sort
by.

3 Optional: To cancel a sent message, highlight it on the Outbound Messages list, and click

.

IMPORTANT: You can only cancel messages in the pending state. If a message is in
any other state, it cannot be cancelled.

The message is cancelled.
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4 Optional: To delete a sent message from the Outbound Messages list, highlight the message

and click . You can highlight several messages at the same time. To do this, when
selecting messages hold the CTRL or SHIFT keys.

IMPORTANT: This operation cannot be undone.

NOTICE: Removing entries from the Outbound Messages list does not remove them
from the log file. For more information regarding the log file, see: Group Text Messaging
Log File on page 113.

The message disappears from the list.

5

Optional: To delete all sent messages from the Outbound Messages list, click .

IMPORTANT: This operation cannot be undone.

NOTICE: Removing entries from the Outbound Messages list does not remove them
from the log file. For more information regarding the log file, see: Group Text Messaging
Log File on page 113.

6.21.4
Group Text Messaging Log File
All sent Group Text Messages are logged to a file.

The default location of the log file is:

• For MCC 7500 VPM: C:\ProgramData\Motorola MCC 7500\MessageMonitorLogs
• For MCC 7500E: C:\ProgramData\Motorola MCC 7500E\MessageMonitorLogs
• For MCC 7100: C:\ProgramData\Motorola MCC 7100\MessageMonitorLogs
The size of the log file is configured in Elite Admin. The size limit for the log file is 20 megabytes.

For each sent message, the following information is logged:

State
Successful or unsuccessful.

Resource
The recipient of the sent message.

Message
The text of the sent message.

Timestamp
The date and time when the message was sent.

Radio Display
The Radio Display option set for the sent message.

Alert Level
The Alert Level option set for the sent message.

MN004387A01-B
Chapter 6:  Elite Dispatch Features

  113



This page intentionally left blank.



Chapter 7

Stack Functionality
The Stack consists of two columns and displays incoming calls on a resource. The calls are listed in
chronological order with the newest entry at the top.

The left-hand column displays the alias of the radio initiating an inbound call or, if an alias is not
defined, the subscriber ID of the radio. "Unknown" means that the radio is not recognized by the
system.

The right-hand column displays any of the several different types of information, depending upon how
the Stack has been configured in Elite Admin.

Figure 20: Elite Dispatch Console Stack

Stack entries feature a right-click submenu of actions — for example, Send Call Alert or
Acknowledge Emergency Alarm.

NOTICE: The contents of the right-click submenu depend on the features available on a
particular channel.

Figure 21: Submenu Options on a Channel with Emergency Features

7.1
Viewing Stack Information
The Dispatch Operator can toggle the information displayed among the available choices.

Procedure:
1 In the right-hand column of the Stack, click the desired Stack entry.

Stack information types are changed sequentially one after the other. Available choices include:

• Status

• Time

• Zone

• Zone ID

• Site

• Site ID

• Secure Key
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• Keyset ID

• Group Text Message

• Group Text Alert Level

• Group Text Radio Display

NOTICE: Currently, the Zone ID is displayed in both the zone and the zone ID fields, and
the site ID is displayed in both the site and the site ID fields.
Active Emergency calls in the stack remain at the top of the stack until they are
acknowledged. Duplicate entries are placed at the top of the stack and the original (older)
entry is removed.

The displayed stack information type changes.

2 Optional: If the Stack is not large enough to display all Stack entry contents, move the mouse
pointer over the Stack entry.

A tooltip showing the full contents of the entry is displayed.

7.2
Deleting Single Stack Entries
The Delete Single Stack Entry toolbar button and menu item are used to delete stack entries.

Procedure:
1 In the stack window of a resource, select the stack entry to be deleted. Click the Delete Single

Stack Entry button.

The selected item is deleted and the entry below it is selected. If there is no entry below it, the
entry above is selected. The Delete Single Stack Entry button is still active.

2 Optional: If the entry is not deleted within a 5 second interval, select it again by repeating step 1.

3 Optional: Delete newly selected entries until no entries are left in the stack.

The Delete Single Stack Entry button becomes inactive.

7.3
Deleting All Stack Entries
The Delete Entire Entry toolbar button and menu item are used to delete the entire contents of the
last stack in which an entry was selected.

Procedure:
1 In the stack window of a resource, select the stack entry to be deleted. Click the Delete Entire

Stack button.

The Delete Entire Stack button becomes disabled and if there are no acknowledged or
unacknowledged emergencies in the stack, all the entries in the stack are deleted. If there are
such emergencies, the following warning message appears: This will delete one or
more Emergency entries from the stack. Remove All stack entries?

2 Optional: In the warning message dialog, perform one of the following actions:

• Delete all stack entries by clicking OK.

• Stop the process and close the window by clicking Cancel.
3 Optional: If the entry is not deleted within a 5 second interval, select it again by repeating step 1.
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Chapter 8

Auxiliary Inputs and Outputs
Operation
Auxiliary Inputs and Outputs (auxios) are external devices such as fire alarms, burglar alarms and door
locks that the Dispatch Operator can monitor and sometimes control using the console. Auxio
resources function differently from radio resources. Instead of linking a dispatcher to a person, auxio
resources are links to devices.

Dispatch Operators can monitor the state (usually on/off or open/close) of input devices, and can both
monitor and control the state of output devices. Some auxios are configured by the Administrator to
include the audible alarm feature.

On the screen, auxios are small windows with pictures that represent two different states: Active and
Inactive.

Auxio active state indicator

Auxio inactive state indicator

Buttons may have the following functions:

Latching Output Auxios
Toggles the state on/off with each click.

Momentary Output Auxios
Enables the state for as long as the button is held down; reverts to original state when released.

Interlocking Auxios
A group of auxios allowing only one member to be active at any time. Interlocked auxios are always
latched, so turning on one auxio in the group latches that group member to the ON state, and turns
off all other members of that interlocked auxio group.

Input Auxios
Shows the status of remote devices monitored by the console. The status of the remote device
cannot be changed.

8.1
Channel-Associated Public Auxios
The System Administrator can configure some auxios to appear as feature buttons on a Radio
Resource. This provides for convenient activation of an auxio when the input/output device is
frequently required by a particular Resource.
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Figure 22: Channel-Associated Public Auxio Feature Button

NOTICE: An auxio button appears in one of three states:

• Inactive

• Active

• Unknown

8.2
Activating and Deactivating Auxios
The Dispatch Operator can activate and deactivate Latching Output Auxios, Momentary Output Auxios,
Interlocked Latching Output Auxios, and Resource-Associated Public Auxios.

Procedure:
1 To activate/deactivate an auxio, perform the following actions:

• To activate/deactivate a Latching Output Auxios, click the Auxio button.

• To activate/deactivate a Momentary Output Auxio, click and hold the Auxio button.

• To activate/deactivate an Interlocked Latching Output Auxio in a group, click the Auxio
button associated with that auxio.

NOTICE: Interlocked auxios are a group of related auxios. Only one of the auxios in
the group can be activated at one time. When one auxio in the group is activated, the
previously activated one is deactivated.

• To activate/deactivate a Resource-associated Public Auxio, click the Auxio feature button on
the Resource.

8.3
Safety Auxios
The system administrator may have configured some auxios so that the operator must activate a safety
switch before the status of the auxio can be changed. This setting prevents the operator from
accidentally changing the status of certain important auxios, such as those that open entrance doors or
sound alarms.

The Safety Switch toolbar button has two posible states:

The Safety Switch is inactive.

The Safety Switch is active.
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Safety-Protected Auxio buttons are marked by a red circle cross.

Safety-Protected Auxio

Auxio in its Normal State

Safety Protected Auxio on Resource

8.4
Activating Safety Auxios
The Dispatch Operator can change the state of an auxio that is protected by a safety switch.

Procedure:
1 Click the Safety Switch toolbar button.

The Safety Switch button turns from red to green and the Safety-Protected Auxio button
changes to its normal state.

2 Within five seconds, select the desired auxio.

8.5
Auxio Audible Alarms
An Administrator may configure Auxios to cause a relay inside the Dispatch Operator equipment to
close when the Auxio is activated. If desired, this relay may be connected to an external audible or
visual alarm.

Figure 23: Ending Audible Alarms on Auxios

Related Links

Ending Auxio Audible Alarms on page 119

8.5.1
Ending Auxio Audible Alarms
Procedure:

1 To end an audible Auxiliary I/O alarm, click the End Audible Alarm toolbar button.
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NOTICE: Clicking the Auxiliary I/O resource on the desktop or deactivating the Auxiliary
I/O does NOT end the audible alarm.

8.6
Auxio Groups
Auxiliary I/O Groups are a convenient way of dealing with multiple auxios sharing commonalities (for
example, all auxios at a certain location).

The behavior of an auxio group is identical with the independent auxio with the exception that all
auxios in a group are glued together; when a group is moved on the screen, all the auxios in the group
move.

Figure 24: Grouped Auxios

Another convenient way of dealing with auxio groups is through the Elite dedicated Auxiliary I/O
Group window. The administrator can configure an auxio group to be displayed in the auxio window.

Figure 25: Auxiliary I/O Group Window

8.6.1
Showing and Hiding the Auxiliary I/O Group Window
The Dispatch Operator can show or hide the window as required.

Procedure:
To show or hide the Auxiliary I/O Group window, click the Show/Hide Auxiliary I/O Window

toolbar button .

8.7
Auxio Pairs
Auxio pairs indicate the status of the command that a dispatch operator triggered to control an external
device. With auxio pairs, the dispatch operator can see that the command is in progress and when it is
completed successfully.Auxiliary Pairs are two momentary auxios of different types that are glued
together. The Auxiliary Input indicates the state of the external device. The purpose of the Auxiliary
Output is to inform the Dispatch Operator that the outbound request to change the state of the Auxiliary
Input was processed by the system.

The Auxiliary Output and the Auxiliary Input buttons may assume the following states:

 Auxiliary Output inactive; Auxiliary Input inactive
The controlled device or feature is inactive.
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 Auxiliary Output active; Auxiliary Input inactive
The action triggered by the Dispatch Operator is in progress.

 Auxiliary Output inactive; Auxiliary Input active
The Auxiliary Input indicates that the controlled device or feature is active. The Auxiliary Output
button indicates that the triggered action ended.

NOTICE: The Auxiliary Output stays active until the state of the Auxiliary Input changes. After
the state of the Auxiliary Input changes, the Auxiliary Output becomes inactive again.

8.7.1
Triggering Auxio Pair Actions
The Dispatch Operator may activate/deactivate a device or feature.

Procedure:
Click the Auxiliary Output button.

The state of the Auxiliary Output button changes into Active to indicate that triggered action is
in progress. After the outbound request to change the Auxiliary Input state has been processed
by the system, the Auxiliary Input button indicates that the controlled device or feature is
active. The Auxiliary Output button indicates that the triggered action ended.

MN004387A01-B
Chapter 8:  Auxiliary Inputs and Outputs Operation

  121



This page intentionally left blank.



Chapter 9

Resource Groups
Temporary Resource Groups can be created to contact multiple radios using different resources
simultaneously, or to allow users from different frequencies to temporarily communicate with each
other.Some groups are pre-programmed by the Administrator. If a Resource Group in a configuration
displays a lock icon, it cannot be edited by the Dispatch Operator.

Resources can be grouped as:

Msel (Multiselect)
A group of resources usually monitoring different frequencies. By placing all resources in a
Multiselect group, the Dispatch Operator can transmit on all of them simultaneously but the
resources cannot communicate with each other.

Patch
A group of resources that can receive messages from the console and transmit to all other
members of the Patch group. Create a Patch group to allow users of dissimilar resources (different
frequencies, different infrastructure) to communicate with each other. Patch groups appear with a

symbol  on their resource tile. The Console Telephony feature makes it possible to add phone
calls to patch groups. The feature is available on the MCC 7500 VPM and MCC 7500E Dispatch
Consoles. You cannot patch a Channel Wide Talkgroup. See the RF Site Technician Reference
Guide for details about Channel Wide Talkgroups.

Primary
Radio resources designated by system Administrators and Dispatch Operators with a higher

handling priority and signified by a diamond symbol  on resource headers.
Primary resource editing can only be performed in the Edit Resource Group window. Any radio
resource can be added to primary groups whether or not it already exists in Msel and Patch groups.

9.1
Primary Resource Indicators
Primary Resources are marked with a diamond symbol. The symbol has no effect on system operation;
it merely aids in visual identification.

Unselected Primary Resource

Selected Primary Resource

During a transmission on a Primary Resource, the diamond symbol is replaced with a transmit indicator
and returns after the transmission ends.

When a Primary Resource is not operational, it is marked with the following icon:

Inoperational Primary Resource indicator
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Partially operational Primary Resource indicator

9.2
Designating Resources as Primary
The Dispatch Operator can designate resources as primary. Only radio resources can be made
primary.

Procedure:
1 From the menu, select Edit → Resource Groups.

NOTICE: If the group is locked by the Administrator, the Lock Group check box is
checked and the arrow buttons are disabled. Locked groups cannot be edited by the
Dispatch Operator.

2 In the Edit Resource Groups window, from the Groups drop-down list, select Primary
Resources.

3 In the Available list, double-click a listed resource.

The resource is moved into the Selected list and shows a diamond symbol, designating it as a
primary resource.

9.3
Multiselect or Patch Groups
The Msel and Patch Group window contains the Multiselect and Patch group folders. Some
Multiselect and Patch groups may have already been set up by the Administrator.

If a pre-programmed group is locked, a lock icon is visible on the Msel or Patch window. Locked
groups cannot be edited by the dispatcher.

Figure 26: Msel and Patch Group Window

A dot next to Msel or Patch group name  indicates that there is at least one resource in that
group.

Temporary groups can be set up by the Dispatch Operator as needed. When a folder in the group
window is selected, it moves to the front of the group window where its associated resources can be
seen.

The group window displays the Multiselect or Patch buttons and the resources that belong to the
group. In the Msel and Patch Group window, the names of Patch and Msel groups that contain
members appear in non-italicized and bold type (for example, Msel 1) for visual identification purposes.
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9.4
Enhanced Patch Groups
Typically for Patched Resources, only the audio from the selected Resources in the Patch is routed to
the headset or the speaker for the selected audio. Enhanced Patch Groups make it possible to hear
audio from all the resources in the patch in your headset or the speaker for selected audio without
having to select them manually.

If an Administrator pre-configured an Enhanced Patch Group in an .elt configuration, the Dispatch
Operator can see it in the MultiSelect/Patch Group window. An Administrator creates an Enhanced
Patch Group by linking a Patch Group to a corresponding MultiSelect Group in the Elite Admin
application. The MultiSelect Group to which the Patch Group is linked disappears from the
MultiSelect/Patch Group window. The interlocking chain icon in the upper-left corner of the patch
group tab indicates that this is an Enhanced Patch Group.

Figure 27: Enhanced Patch Group Indicator in the MultiSelect/Patch Group Window

NOTICE: Another icon typical for Enhanced Patch Groups is the broken interlocking chain icon
that can appear next to a resource added to the Enhanced Patch Group. The icon appears for
the resources that, for some reason, were not added to the Patch Group or the Multiselect
Group that create the Enhanced Patch Group. If the broken interlocking chain appears next to a
resource in the Enhanced Patch Group, the audio for this resource is routed as for a normal
Patch Group resource or for a normal Multiselect Group.

Another difference between an ordinary Patch Group and an Enhanced Patch Group can be the
Transmit button. If the MultiSelect Group to which the Patch Group is linked has the APB transmit
capability, the Patch Transmit button in the Enhanced Patch tab is replaced with the Msel Transmit
button.

If the Administrator does not lock the Enhanced Patch Group for editing, the Dispatch Operator can
edit it like an ordinary Patch Group.

If the Dispatch Operator adds a Phone Resource to an Enhanced Patch Group, it is not selected
automatically like Radio Resources. It must be selected manually.

Dispatch Operator transmissions that use the Msel Transmit button on an Enhanced Patch Group
have a higher priority than Dispatch Operator transmissions that use the Patch Transmit button on a
standard patch group.

9.5
Creating Multiselect Groups
The Dispatch Operator can create a Multiselect Group. When creating a Multiselect Group, the
Resource is selected when it is added to the Group.
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Procedure:
1 In the Multiselect/Patch Group window, select the Multiselect Group folder tab.

The Msel Edit button  and Msel Transmit button  appear.

2 In the Multiselect/Patch Group, click the Msel Edit button to open the group for adding or
removing Resources.

NOTICE: If the Multiselect Group is safety protected, click the Safety Switch 

button, so it turns green . Then you have a predetermined amount of time to select
the desired Radio Resources. The default is 5 seconds.

The border around the group window turns green.

3 Add the Resources to be added to the group by clicking on the desired Radio Resources.

The Resource becomes part of the group and the name of the Resource appears in the group
window.

NOTICE: Attempting to put resources with different transmit modes (secure and clear) in
the same Msel group or Patchgroup causes the console to beep and display a warning
message, indicating a transmit mode mismatch.

4 To close the group, click Msel Edit.

9.6
Creating Patchgroups
The Dispatch Operator can create a Patchgroup. Creating a Patchgroup places a patch icon in the
resource window, showing the Patchgroup number.

Procedure:
1 In the Multiselect/Patchgroup window, select the Patchgroup folder tab.

The Patch Edit button  and Patch Transmit button  appear.

NOTICE: The Patch Edit button displays the number of the Patch folder currently on top.

2 In the Multiselect/Patchgroup, click the Patch Edit button to open the group for adding or
removing Resources.

NOTICE: If the Patchgroup is safety protected, click the Safety Switch  button, so

it turns green . Then you have a predetermined amount of time to select the desired
Radio Resources. The default is 5 seconds.

The border around the group window turns blue.

3 Add the Resources to be added to the group by clicking on the desired Radio Resources.

The Resource becomes part of the group and the name of the Resource appears in the group
window.
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NOTICE: Attempting to put resources with different transmit modes (secure and clear) in
the same Msel group or Patchgroup causes the console to beep and display a warning
message, indicating a transmit mode mismatch.
If the resource contains a patch icon, it belongs to a Patchgroup. If a resource has the
patch icon, but there is no number on the icon, the resource is in a Patchgroup at another
operator position and cannot be patched at this operator position. A resource cannot be
put into more than one Patchgroup in the entire system at any time.

4 Close the group by clicking the Patch Edit button.

If there is no activity in a Patchgroup for a specific period of time (determined by the system
administrator), the group folder name flashes to remind the operator that the Patchgroup still exists and
that the operator may want to delete the members from that group.
If a resource in a Patchgroup becomes unavailable, the Pending Patch indicator appears in the
resource header and in the Patchgroup window, next to the resource name. This indicator also
appears if a resource that you are attempting to add to a Patchgroup is currently unavailable. After the
resource becomes available, the Pending Patch indicator disappears and the resource rejoins the
patch. The Pending Patch indicator is also displayed for a phone resource added to a Patchgroup
without having any call active on it. The Pending Patch indicator disappears only when you have a call
established on the phone resource.

Figure 28: Pending Patch Indicators

9.7
Transmit and Receive Mode Indicators in Groups
When a resource in a Msel or Patch Group is transmitting, the Transmit indicator is displayed in the
Msel or Patch Group window next to the name of that Resource. Similarly, when a resource in an
Msel or Patch Group is receiving an inbound call, the Inbound Call indicator is displayed in the Msel
or Patch Group window next to the name of that Resource.

Figure 29: Transmit and Inbound Call Indicators in the Msel or Patch Group Window
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If the Console is configured in Elite Admin to generate Clear Audio Alerts, the Msel and Patch Group
window displays the Clear Audio Transmit indicator  or the Clear Audio Receive indicator 
when a resource in an Msel or Patch group is transmitting or receiving Clear Audio on a Secure-only
Console.

9.8
Editing Resources in Multiselect or Patch Groups
The Dispatch Operator can change the resources in a temporary group at any time. Pre-programmed
groups locked by the Administrator cannot be edited. A locked group displays a lock icon in the Msel
or Patch group window.

One resource can be added to several Msel groups and only one Patch group in the system.

NOTICE: All Patches and Msels created by the Dispatch Operator are lost when the
configuration is exited or the Dispatch Operator switches to a different configuration. Exiting
Elite Dispatch removes all Resources added to Msel and Patch groups and ends all console
transmissions.
If a Talkgroup is added to a Patch group, the Talkgroup does not receive calls from any
Multigroup that it is associated with until it is removed from the patch.

Procedure:
1 In the Msel and Patch group window, select the folder of the group.

2 In the group window, perform one of the following actions:

• To open a Multiselect group, click the Msel button.

• To open a Patch group, click the Patch button.

NOTICE: If the Multiselect Group is safety protected, from the toolbar select the Safety

Switch button , so it turns green .

3 Select the resources to edit within the group. When finished using a group, delete all its
members.

4 Close the group by performing one of the following actions:

• To close an Msel group, click the Msel button.

• To close a Patch group, click the Patch button.

9.9
Editing Resources in Any Group
The Dispatch Operator can edit Multiselect, Patch, and Primary Resource Groups not locked by the
Administrator.

Procedure:
1 From the menu, select Edit → Resource Groups.

2 In the Edit Resource Groups window, from the Groups drop-down list, select an Msel, Patch,
or Primary Resource Group.

NOTICE: Primary Resource Groups that cannot be edited are marked by the disabled
arrow buttons and the View Only status.

3 From the Type drop-down list, select Radio to see listed resources in the Available list.

Only resources assigned to folders appear in the list.
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NOTICE: A Radio Resource can be placed in only one Patch group in a configuration.
However, a radio resource can be placed in multiple Multiselect groups.

4 Perform the following actions:

• To add a resource to the group, select it from the Available list and click on the right arrow
button.
The resource is added to the Selected list.

• To delete a resource from the group, select it from the Selected list and click on the left
arrow button.
The resource is removed from the Selected list and is available for assignment to another
Group.

5 When all changes are made, click Close.

9.10
Transmitting to Patchgroups and Enhanced Patchgroups
Perform this procedure to transmit to Patchgroups and Enhanced Patchgroups.

Procedure:
1 In the MultiSelect/Patchgroup window, select the Patchgroup to which you wish to transmit.

2 Optional: For Enhanced Patch Groups only: If you wish to hear the whole patch audio in the
headset or selected speakers, open the Enhanced Patch Group by clicking the Patch Edit

button .

If you do not open the Enhanced Patch Group, the patch audio is streamed to the unselected
audio destinations configured for the resources.

3 Perform the following actions:

• If the Patch Transmit button is available, click the Patch Transmit button .

• If the Patch Transmit button has been replaced by the Msel Transmit button, click the Msel

Transmit button .

CAUTION: If you use a footswitch, microphone, or headset General Transmit button to
transmit on the enhanced patchgroup, do not make the following changes to the
enhanced patch group while you transmit on it:

• Do not open or close the enhanced patch group.

• Do not remove resources from the enhanced patch group.

4 Speak into the microphone.

5 When done speaking, release the Transmit button.

9.11
Sending General Transmits to Multiselect Groups
Perform this procedure to send General Transmits to Msel Groups.
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Procedure:
1 Select the Msel folder of the group you wish to transmit to.

The folder moves to the front and lists all the resources in the group.

2 On the left of the group window, click the Msel button.

The group window and the borders of all resources in the group change to green. The combined
audio of all resources in the group is heard from the select speaker.

3 Click and hold the General Transmit button.

A red lightning bolt appears in all resources in the group for the duration of the transmission.

4 Speak into the microphone.

5 After you finish speaking, release the General Transmit button.

9.12
Sending APB and Patch Transmits
An All-Points Bulletin (APB) is a method of quickly transmitting to a Multiselect group without first
opening the group. An APB transmission has the same priority as Instant Transmit.

The procedure for transmitting to a Patch Group is similar to an APB transmit, except that the Dispatch
Operator selects a Patch group instead of a Multiselect group.

Procedure:
1 Select the desired group folder.

2 Perform one of the following actions:

• To send an APB Transmit, click the Msel Transmit button.

• To send a Patch Transmit, click the Patch Transmit button.

A red lightning bolt appears next to all resources that are members of the group.

3 Speak into the microphone.

4 After you finish speaking, release the transmit button.
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Chapter 10

Event Display
Event Display is an optional feature that provides Dispatch Operators with a call queue window for
radio messages, radio statuses, and emergency alarms (as opposed to handling inbound events
through the resource windows).

10.1
Event Display Window Description
This figure shows an example of an Event Display window. The Administrator configure the columns,
menu options, and buttons in this window. Each row in the display area of the window is an event. The
number of rows can be between 25 and 1,000 and is also configured by the Administrator.

Figure 30: Event Display Window

 Title Bar
Shows the name of the Event Display configuration.

 Menu Bar
Displays the menus. The Administrator configures the contents.

 Preview Tile
Displays the radio resource currently acknowledged in the Event Display list.

 Operations Buttons
Displays the buttons available to a Dispatch Operator used to respond to inbound events. The
Administrator configures the contents.

 Column Title Button
Displays columns for event message data configured by the Administrator. Column width can be
changed by clicking and dragging a column divider.

 Primary Resource Indicator
If configured, displays an asterisk ( * ) beside resources designated as primary.

MN004387A01-B
Event Display

  131



 Status Indicators
Displays an icon for the status of the message event as shown below. No status indicator for an
event means no action has yet been taken.

 Error Log
Displays timestamp and error messages (if any).

 Indicator Panes
Appears in the status line at the bottom of the Event Display window. Icon indicators are displayed
for error messages, resources disabled, and system status.

 Clock
Displays the current time; it is synchronized with the console Windows domain controller.

10.2
Event Display Menu Options
This table presents all possible options and operations of the Event Display. Because the system
Administrator customizes the window to suit the needs of operators, your configuration may not include
all items shown here.

Table 2: Event Display Menu Options

Menu Option Menu Item Description

Event Display Hide Hides the Event Display window. To show the window,
select Show Event Display from the View menu of the
main Dispatch window.

Operations Acknowledge Acknowledges a selected event and opens communica-
tion between a Dispatch Operator and the resource
through the Transmit button on the preview tile in the
Event Display window. Audio is routed to the Select
speaker.

Acknowledge Next Acknowledges the entry at the top of the list.

Hold Puts a selected event on hold.

Delete Deletes the selected event.

Delete by Unit Deletes all messages in the queue associated with the
selected unit.

Delete by Resource Deletes all messages in the queue associated with the
selected resource.

Delete All Deletes all events without selecting any item in the
Event Display queue.

Clear Error Line Clears the error message in the status line at the bottom
of the Event Display window.

End Emergency
Tones

Stops all emergency tones.

Audible Indication Plays an audible tone when the console receives an
event. You can configure the audible tone to play for
events from Primary Resources or from all Resources.
You can set the audible tone to repeat at an interval of
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Menu Option Menu Item Description

3-60 seconds when events in the queue are unacknowl-
edged or on hold.

View Activity Log Shows/hides the Activity Log window.

Auxiliary I/O Win-
dow

Shows/hides the Auxiliary I/O (Auxio) window.

Error Log Shows/hides the error log.

Help Contents Opens the Online Help for the Elite Dispatch application.

About MCC 7500
Elite/About MCC
7500E Elite/About
MCC 7100 Elite

Displays copyright information and software version
number.

10.3
Event Display Operations Toolbar Buttons
The Event Display Operations toolbar provides quick access to frequently used menu items.
Because the system Administrator customizes the operations buttons to suit the needs of operators,
your configuration may not include all buttons shown here.

 Acknowledge
Acknowledges a selected event and opens communication between a Dispatch Operator and the
resource through the Transmit button on the preview tile in the Event Display window. Audio is
routed to the Select speaker.

 Acknowledge Next
Acknowledges the entry at the top of the list.

 Hold
Puts a selected event on hold.

 Delete
Deletes the selected event.

 Delete by Unit
Deletes all messages in the queue associated with the selected unit.

 Delete by Resource
Deletes all messages in the queue associated with the selected resource.

 Delete All
Deletes all events without selecting any item in the Event Display queue.

 End Emergency Tones
Stops the emergency tone at the dispatch position.
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 Audible Indication
Plays an audible tone when the console receives an event. You can configure the audible tone to
play for events from Primary Resources or from all Resources. You can set the audible tone to
repeat at an interval of 3-60 seconds when events in the queue are unacknowledged or on hold.

10.4
Responding to Calls in the Event Display
An incoming event from a radio resource is added to the Event Display queue. Several sorting orders
are in the Event Display that can be configured by the Administrator. Likewise, a double-click action
on an entry can be configured to automatically acknowledge an event or place an event on hold. Ask
your system administrator or consult your organizational documentation to see how your system
functionality has been configured.

Procedure:
1 Select the event entry in the queue.

2 In the Operations toolbar, perform one of the following actions:

• If the Acknowledge button is available in the Operations toolbar, click the Acknowledge
button.

• If the Acknowledge button is not available in the Operations toolbar, from the Event
Display menu, choose Operations → Acknowledge.

The preview tile appears at the top of the Event Display window.

3 Optional: To open a compressed preview tile, on the preview tile in the Event Display window,
click the down arrow button.

All the feature buttons for that resource are displayed within the Event Display window.

4 To communicate with the radio, on the preview tile, click the Instant Transmit button.

NOTICE: Only one resource can be acknowledged at a time. Depending on the sorting
order configured by the system Administrator, an acknowledged event may change its
position in the queue.

10.4.1
Placing Events on Hold
A Dispatch Operator can place events temporarily on hold.

Procedure:
Select the event entry in the queue and click the Hold button in the Operations toolbar.

• If the Hold button is not available in the Operations toolbar, select the entry and from the
Event Display menu, choose Operations → Hold.

• If the Administrator provides a proper configuration, you can put events on hold by double-
clicking them.

10.4.2
Deleting Entries from the Event Display Queue
The Dispatch Operator can delete unnecessary entries from the Event Display Queue.
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Procedure:
Select the entry and click the Delete button in the Operations toolbar.

• If the Delete button is not available in the Operations toolbar, select the entry and from the
Event Display menu, choose Operations → Delete.

• If the Administrator provides a proper configuration, you can automatically delete events by
clicking the Acknowledge or Acknowledge Next button.

10.5
Responding to Emergency Alarms in the Event Display
An Emergency Alarm appears in bold red font in the Event Display window. The outline of the preview
tile changes color when the emergency is acknowledged.

Procedure:
1 In the Event Display queue, select the Emergency Alarm event.

2 In the Event Display Operations toolbar, click the Acknowledge button.

3 Communicate with the radio.

When an emergency alarm is acknowledged from either the Event Display or the Elite Dispatch main
window, both interfaces are updated accordingly.
After all emergency events for a channel or talkgroup have been acknowledged, deleting the last
acknowledged emergency event for the resource from the Event Display causes the Emergency
Knockdown operation to be executed, which in turn causes the Elite Dispatch main window interface
to be updated.

10.6
Modifying Event Display Preferences
If the Administrator has allowed modifications in the Dispatch Application, an operator can change the
Event Display preferences. Changes made by the operator remain in effect only until Elite Dispatch
is exited.

Procedure:
1 In the Elite Dispatch main menu, select Edit → Event Display.

2 In the Properties and Customize panel, select Preferences.

3 In the Preferences pane, click the Customize button.

4 To show the Event Display window upon Dispatch startup, in the Customize Event Display
Preferences window, click the Show Event Display check box.

5 In the Customize Event Display Preferences window, perform the following actions:

a To cause an audible tone at the console when an event is received, select the Enable
Audible Indication check box.

b Choose whether the audible tone applies to events for Primary Resources only or all
Resources by selecting one of the buttons.

c To cause an audible tone to repeat at intervals when events in the queue are
unacknowledged or on hold, select the Repeat Every check box. In the spin box, select the
interval in seconds.

The repeat interval for the audible indication can be set in the range of 3-60 seconds. In Elite
Dispatch, changes to the repeat interval are applied immediately.

6 In the Total Rows field, select the total number of rows on the Event Display window.
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7 In the Selected Content list, select the check boxes for the columns you want to display in the
Event Display window. See Event Display Window Columns on page 136.

8 Change the order of the content by selecting an item and using the Move buttons to move it up
or down in the list.

If Event State is selected, it must be the top entry in the list.

Items in the list are displayed from left to right in the Event Display window.

9 To accept the preferences settings and close the dialog, click OK.

Related Links

Event Display Window Columns on page 136

10.6.1
Event Display Window Columns
The Dispatch Operator can select the columns displayed in the Event Display window. The following
list describes the options available for selection.

Event State
The state of the event, either Unacknowledged, Acknowledged, or Held.

Resource
The resource name/the phone line.

Unit Alias
The alias name for the radio unit, the called phone, or the called phone number.

Alias
The alias for the status code/message code.

Time
The time stamp of the event.

Site
The RF site ID from which the event was received.

Zone
The zone ID in which the event was received.

Primary Resource
Allows a primary resource indicator (an asterisk *) to be displayed next to resources designated as
primary. No indicator means the resource is not primary.

Unit ID
The ID of the radio unit or the ID of the called phone unit.

Event
Either a text wording of the message or status code, or the event type (for example, Emergency
Alarm).

Code
The message/status code of the event.

Secure Key
The encryption key number for a resource.

Sequence Number
The events are numbered in a sequence of 1, 2, 3, and so on. The top entry in the queue has a
sequence number 1. When an entry in the queue is added, removed, or changes position, the
sequence numbers are updated accordingly.
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Elapsed Timer
The time from the first event for a given radio displayed in the Event Display window, regardless of
the event type. A blank entry is used for the first event for a given radio.

Related Links

Modifying Event Display Preferences on page 135

10.7
Event Display Log Files
You can save all Event Display message event data regardless of the selected columns. You can open
log files with Notepad and import them into Microsoft Excel.

Table 3: Default Log File Settings

Description Setting

Default location for
saving log files

MCC 7500 VPM
Dispatch Consoles

C:\ProgramData\Motorola MCC
7500\MessageMonitorLogs

MCC 7500E Dis-
patch Consoles

C:\ProgramData\Motorola MCC 7500E
\MessageMonitorLogs

MCC 7100 Dispatch
Consoles

C:\ProgramData\Motorola MCC
7100\MessageMonitorLogs

Default log file name <Current_ELT_Name>.<Current_IED_Name>
.log

Figure 31: Event Display Log File - Example
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Chapter 11

Troubleshooting
This chapter describes various events that can occur during the daily operation of the Motorola Elite
Dispatch, and explains what to do in case of hardware or software failure.

11.1
Error Messages
If the console beeps indicating that an action could not be completed, see the error message displayed
in the status line at the bottom of the Elite Dispatch window for an explanation.

Most error messages are self-explanatory and occur if an action is attempted that is not possible at the
time (such as attempting to patch transmit to a group with no members). Warnings and informational
messages also appear in the status line. Some of the messages are also logged to the Windows
Application Event Log.
Cannot begin Private Call: resource is unavailable

The Private Call cannot be initiated because the resource is not available.
ZIPC_900001 not assigned — already assigned elsewhere on console position

Only one Private Call Resource can be assigned at this console and the resource has already been
assigned.

Critical configuration parameters have changed — please reply the PC to
utilize the updates

If the system is configured for Dynamic System Resilience (DSR), a critical configuration change
causes this message to be displayed.

Some error messages instruct the Dispatch Operator to contact the System Administrator. Please
notify the supervisor or the System Administrator if this error message appears at the console.

• If the computer screen freezes and does not respond to the keyboard or the mouse, call the system
administrator for assistance.

• If Trunked Resources fail after the Dispatch Operator position has been reprogrammed, restart the
Elite Dispatch program.

• If the computer is powered up but there is no display on the monitor, ensure that all cables are
securely plugged into the back of the computer and the monitor. Ensure that the computer and
monitor power cords are securely plugged into a 120 VAC, 60 Hz grounded power outlet.

• If a problem appears to be with the computer itself, see the manuals that came with the computer.

• If a problem with the console is suspected, notify the supervisor.

Related Links

Viewing Previously Displayed Error Messages on page 140
Clearing the Status Line on page 140
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11.1.1
Viewing Previously Displayed Error Messages
Procedure:

1 At the end of the status line, click the down arrow button.

A list of the most recent error messages is displayed.

2 To close the list, click anywhere within the Elite Dispatch application.

Related Links

Error Messages on page 139

11.1.2
Clearing the Status Line
Procedure:

1 From the menu, select Features → Clear Status Line.

NOTICE: The previous messages are still viewable by using the down arrow button at
the end of the status line.

Related Links

Error Messages on page 139

11.2
System Status Indicator
The System Status indicator  appears in the status line at the bottom of the Elite Dispatch
window.

The indicator appears under the following conditions:

• If the system goes into a non-functional or partially functional state

• If the radio system controller becomes unable to communicate with the console

• If the system switches to Conventional Site operation (whereby calls are routed through
conventional channels co-located at your console site)

If this indicator appears in the status line, click it to open the System Status window in which you can
determine what has changed in the status of the system.

Related Links

Investigating Changes in System Status
Viewing System Status on page 142

11.3
System Status
The System Status feature provides a mechanism to report the current system status at an operator
position.
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The System Status window has several sections as shown in the following example:

Figure 32: System Status Window Overview

Related Links

System Components Status Indicators on page 142
Viewing System Status on page 142
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11.3.1
Viewing System Status
The Dispatch Operator can view reports on the current system status at their position.

Procedure:
To open the System Status window, perform one of the following actions:

• On the toolbar, click the System Status button.

• From the menu, select Features → System Status.

• On the status line, click the System Status indicator.

The System Status window appears and the Dispatch Operator can view the status of the
different parts of the system.

Related Links

System Status on page 140
System Components Status Indicators on page 142
System Status Indicator on page 140

11.3.2
System Components Status Indicators
The System Status feature allows the Dispatch Operator to view the status of peripherals, the trunking
system, the conventional system, and localized aliasing as well as the Console Link Status. The
different statuses are represented by icons.

Peripherals Status Indicators

All peripheral ports on the Voice Processor Module (VPM) are functional.

None of the peripheral ports on the VPM are functional.

Only some of the peripheral ports on the VPM are functional.

Console Connection Status Indicators

Console is functioning in PRIMARY mode and connected with a Controller in wide mode. Or this
Console is connected to a Primary Controller.

Console is in IDLE mode.

Console is connected to a Controller in BACKUP mode or connected to a Backup Controller.

System is in UNKNOWN mode.
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Console Site Link Indicators
Status

• Active – Console owns the Active link to the Primary/Secondary Controller

• Inactive – Console owns the Inactive link to the Primary/Secondary Controller

• Passive – Console does not own any link to the Primary/Secondary Controller

Active Console
The last octet of the IP address of the Active Console for the Primary/Secondary Controller.

Inactive Console
The last octet of the IP address of the Inactive Console for the Primary/Secondary Controller.

Localized Aliasing (Console Alias Manager) Indicators
The alias source from which Console downloads radio aliases can be either the hostname of Advanced
Distribution Server (ADS) or Console Alias Manager (CAM) server, or the hostname of Zone Database
System (ZDS) for backward compatibility (prior A7.17 releases).

Connection with the alias source (indicated in the above Alias Source field) is fully functional.

Connection with the alias source is not functional.

Connection status with the alias source is unknown.

Related Links

System Status on page 140
Viewing System Status on page 142

11.4
Audio Processing Messages
The Audio Processing Status messages provide a user with real-time status indications of the audio
processing subsystem through both initialization and run-time phases of operation.

When the audio processing subsystem becomes unavailable, a message window appears with a
reason for the outage. This information is not necessarily directly useful to dispatch operators, but it
enables service technicians and support personnel to quickly identify root causes of the problem and
take action to resolve it.

Depending on the status of the audio connections in your system configuration, Elite Dispatch may
display the following messages:

Initializing Audio Hardware
This message appears during the initialization phase of the audio processing subsystem and can
be present for up to three minutes. It disappears on its own after the audio processing subsystem
and/or peripherals breakout device complete initialization. If the message persists, contact your
system technician.

Audio Processing is not available
This message appears when the audio processing subsystem and/or peripherals breakout device
are unable to provide audio processing services.
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The causes of the problem can be failures at run-time such as loss of connectivity between the
computer host and peripherals breakout device, or failures during the initialization of the audio
processing subsystem and/or peripherals breakout device.

In addition to the information about the audio processing unavailability, the message provides the
user with specific reason codes.

Several evolutions of the audio processing subsystem and peripherals breakout devices are in use.
Service technicians can help identify which subsystems are in use at the console site.

The Voice Processing Module (VPM) is identified by a LAN connection between the computer host and
VPM.

The Audio Interface Module (AIM) is identified by a USB connection between the computer host and
AIM. The AIM peripheral breakout device is an optional component of the audio processing subsystem
on the MCC 7100 and the MCC 7500E platform and does not directly affect audio processing status.
However, some of the reason codes for audio processing service states apply for resources of the
audio processing subsystem within the computer host.

Table 4: Audio Processing Message Reason Codes, Causes and Possible Resolutions

Audio Processing Status Reason Code Causes and Possible Reso-
lution

Audio Processing Not Availa-
ble

No valid configuration data or
valid database present.

Confirm that the console/
Archiving Interface Server
(AIS) position is configured
correctly at the Network Man-
agement interface provided for
your system.

Computer Host application is
not configured for Console or
Logging Interface Server oper-
ation.

Confirm that the computer
host is configured for console
or logging interface server
(AIS) functionality at the Net-
work Management interface
provided for your system.

Unknown computer Host appli-
cation configuration.

Confirm that the computer
host is configured for console
or logging interface server
(AIS) functionality at the Net-
work Management interface
provided for your system.

Network or Connection inter-
face between computer and
audio subsystem or peripher-
als breakout device is discon-
nected/missing.

For VPM-based peripheral
devices: Confirm the comput-
er host and VPM have IP con-
nectivity to the Console LAN.

Audio Processing subsystem
or peripheral breakout device
is reporting out of service.

Audio processing services are
not available for reasons un-
specified. Contact service per-
sonnel for assistance in diag-
nosing potential problems with
configuration or run-time
events such as loss of connec-
tivity between computer host
and peripherals breakout de-
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Audio Processing Status Reason Code Causes and Possible Reso-
lution

vice that can contribute to this
issue.
If this message is displayed
intermittently, for 10 sec-
onds or less:
Check speed/duplex of all de-
vices attached to the console
LAN to verify all devices are
configured for 100 Mbit/Full
Duplex operation. Switches on
the console LAN must also be
set for 100/Full and not config-
ured for auto-negotiate.

If this message is displayed
continuously, for longer
than five minutes:
Confirm that the computer
host has IP connectivity to the
Console LAN and is using the
correct IP address.

VPM-based peripheral devices
only: Confirm that the VPM
has IP connectivity to the Con-
sole LAN and is using the cor-
rect IP address.

Critical components of the au-
dio processing subsystem
have failed or could not be ini-
tialized.

Audio processing services are
not available due to failed initi-
alization of the audio process-
ing subsystem or peripherals
breakout device. Confirm con-
figuration settings of the com-
puter host and peripherals
breakout device (if applicable).

USB connection was lost and
restored (due to plugging and
unplugging the USB AIM de-
vice).

USB AIM device may occa-
sionally stop transmitting or
playing audio after re-plugging
it into the same USB port. De-
pending on how many times
AIM device was re-plugged,
you may see:

• A warning against potential
audio loss

• A prompt to reboot the
computer

Verify that the USB AIM de-
vice is not transmitting or play-
ing audio but there is no prob-
lem with the connectivity. The
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Audio Processing Status Reason Code Causes and Possible Reso-
lution

following indications are visible
in the user interface:

• The red lightning bolt ap-
pears on the selected re-
source when pressing Gen-
eral Transmit or Instant
Transmit.

• The speaker icon appears
on a selected resource
when inbound call is initi-
ated.

• VU-Meter is not showing
volume change in both in-
bound and outbound calls.

NOTICE: Perform
the first step and
continue only if the
audio is not being
processed and VU-
meter is not showing
volume change.

1 Replug AIM USB device to
another USB port.

2 Restart Motorola Elite Dis-
patch.

3 Restart the Dispatch Con-
sole computer.

Audio Processing Initializing Initializing network connectivi-
ty, preparing configuration.

Communication is being es-
tablished with the audio pro-
cessing subsystem and/or pe-
ripherals breakout device to
prepare for configuration data
from computer host.

Audio subsystem and periph-
erals breakout device initializa-
tion in progress.

Initialization of the audio pro-
cessing subsystem and/or pe-
ripherals breakout device is in
progress. The process can
take up to three minutes.

11.5
Responding to the Application Deactivated Message
If Elite Dispatch goes out of service, the Application Deactivated message is displayed.

Procedure:
1 Perform one of the following steps:

• Wait until Elite Dispatch is back in service.
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• Shutdown the application by clicking the Shutdown button.

NOTICE: If you choose to wait until Elite Dispatch is back in service, wait until the
Application Deactivated message disappears. After this message disappears, the
configuration file that was open at the time that Elite Dispatch went out of service may be
automatically reloaded.
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